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Introduction

Introduction

Harmony is a complex and full-featured animation suite that is designed for both small and large scale
productions. In order to respond to the different needs of studios, Harmony is not only able to run as a stand-
alone application, but also as a production server, a web server and a render farm. This guide goes through all
the required steps to install and configure Harmony for all usage scenarios and on all supported platforms.
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Chapter 1: Basic Installation

Chapter 1: Basic Installation

The following section explains how to install Toon Boom Harmony on a workstation. If you intend to use
Harmony as a stand-alone application, this is the only section of the installation guide that you need. If you
intend to use Harmony with a database server, you will need to refer to this section for installing the application
package on your Harmony database server and its client workstations.
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About Windows Installation

Installing Harmony on Windows is a straightforward process consisting mostly of running the installation

wizard, then activating the product.

Installing Harmony Dependencies on Windows

Installing Harmony on Windows __................

Adding Harmony Executables to the %PATH% Environment Variable on Windows _......__.................
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Installing Harmony Dependencies on Windows

On Windows, some features of Harmony rely on the following software:

« Windows Media Player must be installed to enable Harmony's audio and video transcoding capabilities.
On most consumer versions of Windows, it is installed by default and only specific editions of Windows
donot haveiit.

NOTE

Windows Media Player is not supported on Windows 7 Starter and Windows 7 Home
Basic.

o QuickTime Player is required to export movie files in QuickTime Movie (.mov) format as well as to import
any type of movie file. Withiout QuickTime Player, Harmony can still export QuickTime Movie (.mov) files,
but only with the H.264 (AVC) video codec and with uncompressed (PCM) audio. However, Harmony
does not need QuickTime Player to launch and can be used without it.

o Adobe Reader is required on Windows 7 and Windows 8.1 in order to read PDF documents. It can also
be installed on Windows 10, but Windows 10 is bundled with Microsoft Edge, which can be used to
read PDFfiles.

How to install Adobe Reader

1. Toinstall Adobe Reader, follow the instructions are the following address:

adobe.com/support/downloads/pc

How to install QuickTime Player

1. Toinstall QuickTime Player, download and run the installer from the following address:

apple.com/quicktime/download/pc

How to install Windows Media Player

1. Windows Media Player is pre-installed on most versions of Windows, but may be disabled. Follow
these steps to make sure it is enabled.

14
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a. Open the Windows Control Panel:

o On Windows 7: Open the Start menu and select All Programs > Accessories >
System Tools > Control Panel.

e On Windows 8.1 or Windows 10: Open the Start menu and, in the programs list,
select Windows System > Control Panel.

b. Fromthe Control Panel, go to Programs > Turn Windows features on or off.

c. Inthelist of Windows features, find and expand the Media Features option. Windows Media
Player should listed under Media Features. If either of these options are not listed, see below.

d. Ensure both the Media Features and Windows Media Player check boxes are checked.
e. Click OK.

f. Wait for the installation to finish.

g. Restart Windows.

2. If Media Features or Windows Media Player is not listed in the available features, make sure your
edition of Windows supports it. If it does, it may be added by installing the Media Feature Pack for
Windows. To do this, click on the link corresponding to your version of Windows and follow the
instructions:

o Media Feature Pack for Windows 7:

https://www.microsoft.com/download/details.aspx?id=16546

o Media Feature Pack for Windows 8:

https://www.microsoft.com/download/details.aspx?id=30685

o Media Feature Pack for Windows 10:

https://www.microsoft.com/download/details.aspx?id=48231
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Installing Harmony on Windows

You can install Harmony on Windows by running the installation wizard. Once the installation process is
finished, you will need to activate Harmony before you can use it.

NOTE

You need an account with administrator privileges to launch the installer.

How to install Harmony on Windows

1. In afile browser, double-click on the installer package you have downloaded.

2. When prompted by Windows, give the permission to the installer to make changes to your device.

NOTE

If you are not currently logged in with an administrator account, you will need to provide
the username and password of an account with administrator privileges.

3. Inthe Choose Setup Language prompt, select the preferred language for the installation process
and for reading the end-user license agreement.

4. Wait for the installer to prepare the installation.
5. In the welcome screen, click on Next.

6. If you accept the license agreement presented in the installation wizard, select | accept the terms in
the license agreement, then click on Next. Otherwise, click on Cancel.

7. If youwant toinstall Harmony in the default installation directory, select Next. Otherwise, click on
Change and select a preferred installation directory.

8. In the Installation Type dialog, select the appropriate package type:

« Ifyouintend to work in a Harmony Server environment, whether as server or as a client
workstation, select Complete.

« Ifyouonlyintend to work in a fully standalone environment or if you only intend to connect to
a Harmony database using WebCC only, select Standalone.

9. Click on Install.

10. Wait for the installation process to finish. Once the process is finished, you are ready to launch the
application.

11. Open the Windows Start menu.

12. Inthe Programs list, select Harmony 17 [Edition) > Harmony [Edition].

16
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13. Ifyour product is not activated, the Toon Boom Activation Wizard will launch. For information on
how to activate Harmony, see the Toon Boom License Activation Documentation at the following
address:

https://docs.toonboom.com/help/activation

17
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Adding Harmony Executables to the %PATH% Environment Variable
on Windows

You can add the path to the Harmony executable files to the $PATH% environment variable. This will allow you
to run Harmony and its applications and utilities from the command line by typing the name of the executable
files, without having to type their full path.

NOTE

You need an account with administrator privileges to do this.

How to add Harmony executables to the %PATH% environment variable on Windows

1. Inthe Start menu, open the Programs menu and select Harmony 17 [Edition] > Tools >
Configuration Wizard.

2. When prompted, enable Configuration Wizard to make changes to your device.

3. Inthe Toon Boom Harmony Configuration dialog, select the ... button right of Add Harmony to
Path.

4. Ifyouonly want to add the Harmony executables to the $PATH% variable for your own user, select
Single User. If you want the Harmony executables to be in the $PATH% variable regardless of who is
logged in, select All Users.

5. Select Next.
6. Click on Finish.

7. Toverify that the change has been applied, open a new Command Prompt window and type the
following command:

echo %$PATH%

The path to the Harmony bin folder should be included in the output, separated by other paths
with a semi-colon.

18
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About macOS Installation

On macOS, Harmony is provided in an Apple Disk Image (. dmg) file, which contains the software package. The
installation procedure mostly consists of copying its content to the Applications directory of your macOS

computer.

Installing Harmony on macOS L 20
Launching Harmony and Side Applications on macOS .. . 21
Adding Harmony Binaries to the SPATH Environment Variableon macOS ..................................... 22
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Installing Harmony on macOS

Toinstall Harmony on macOS, you must open the Apple Disk Image (.dmg) file, then copy its content to the
Applications folder on your machine. You will need administrator privileges to be able to add applications to the
Applications folder.

How to install Harmony on macOS

1. In afile browser, double-click on the application package you have downloaded.
Then the License Agreement prompt appears.

2. Ifyouaccept the license agreement presented by the application package, click on the Agree
button. Otherwise, click on Disagree.

TIP

If you want to see the license agreement in another language, select a language in the
language drop-down above the license agreement.

3. Wait for macOS to verify the content of the package.
4. Inthe Finder window that opens, select [Zl Toon Boom Harmony 17 [Edition].

5. Drag and drop the selected folder over Applications.

NOTE

If you are not logged-in as an administrator user, you will be prompted by macOS to
enter the log-in and password of a user with administrator privileges to authorize
making changes to the Applications folder.

6. Wait for the package to finish copying.

Once the package is done copying, Harmony is installed.

20
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Launching Harmony and Side Applications on macOS

Harmony is packaged with several side applications. However, in order to comply with the security
requirements of macOS, Harmony is packaged like a single application since Harmony 17. In order to be able to
launch its side applications, you must first launch Harmony, then select a side application from the top menu.

How to launch a Harmony side application when using Harmony Stand Alone

1. In Finder, proceed to Applications > [Zll Toon Boom Harmony 17 [Edition].
2. Double-click on H Harmony [Edition].
The main Harmony application launches and the Welcome dialog appears.

3. Tolaunch License Wizard, Play, Configuration Assistant or Configuration Editor, open the
Harmony [Edition] top menu, select Tools and, in the sub-menu, select the application you want to
launch.

How to launch a Harmony side application when using Harmony Server

1. In Finder, proceed to Applications > [l Toon Boom Harmony 17 [Edition].
2. Double-click on H Harmony [Edition].
The main Harmony application launches and the log-in dialog appears.

3. Do one of the following:

o Ifyouwant to launch Control Center, simply click on the m Control Center button in the
bottom-left corner of the log-in dialog.

« If youwant tolaunch any other side application, such as Paint, Play, Scan, Configuration
Assistant, Configuration Editor, License Wizard or Service Launcher, open the Harmony
(Edition] top menu, select Tools and, in the sub-menu, select the application you want to
launch.

21
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Adding Harmony Binaries to the SPATH Environment Variable on
macOS

You can add the path to the Harmony binary files to the $PATH environment variable. This will allow you to run

Harmony and its applications and utilities from a terminal by typing the name of the executable files, without

having to type their full path.

How to add Harmony binaries to the SPATH environment variable on macOS

1.

In Finder, proceed to Applications > il Toon Boom Harmony 17 [Edition] and double-click
Harmony [Edition].

The main Harmony application launches.
In the top menu, select Harmony [Edition] > Tools > Configuration Assistant.

In the Welcome screen, check the Register console applications in the path option and uncheck all
other options.

Click on Continue.

If you only want to add the Harmony binaries to the $PATH variable for your own user, select
Register Path for my user only. If you want the Harmony binaries to be in the $PATH variable
regardless of who is logged in, select Register Path for all users.

NOTE

You need an account with administrator privileges to register the path for all users.

Click on Create.

If you selected Register Path for all users, you will be prompted to enter an administrator's username
and password to authorize the change.

To verify that the change has been applied, open a new Terminal window and type the following
command:

echo $PATH

The path to the Harmony bin folder should be included in the output, separated by other paths
with a colon.
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About GNU/Linux Installation

On GNUJ/Linux, Harmony is distributed as an application package in a compressed archive and is bundled with
an installation script. Just like a regular installer, the installation script can install the package and add shortcuts
to the applications to your desktop environment, but it is also able to perform the basic configuration routines if
you want to install a database or WebCC server or to set-up a batch processing node.

Harmony is built to support the following operating systems:
o CentOS 6/ Red Hat Entreprise Linux 6
e CentOS 7/ Red Hat Entreprise Linux 7 (up to 7.3).

The installation instructions will presume you are working on a fresh installation of one of these operating
systems.

If you attempt to install Harmony on another GNU/Linux-based operating system, keep in mind that:
o Thisis not a supported scenario.

o Harmony may crash when proceeding to the Welcome screen or main application window. This issue is
known to occur on later versions of CentOS 7 (starting with 7.4) as well as of Fedora 23 and later. It may
be possible to work around this issue—see Troubleshooting a Crash When Loading Harmony on
GNU/Linux on page 42.

« Harmony may fail to launch and it may be impossible to work around the issue.

« Harmony's daemons may not be compatible with the daemon system on your operating system, which
means the use of Service Launcher or the creation of custom-made launch scripts may be required to set
up a database server, a WebCC server or a batch processing node.
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About GNU/Linux Installation

When you install GNU/Linux, you have several options as to the software packages that come pre-installed
with it. To avoid dependency issues, you should install GNU/Linux with a desktop environment and a full suite
of desktop software. More specifically:

« When installing CentOS 6 or Red Hat Entreprise Linux 6, you should install the Desktop or Software
Development Workstation software set.

« When installing CentOS 7 or Red Hat Entreprise Linux 7, you should install the GNOME Desktop or
Development and Creative Workstation base environment.

IMPORTANT

It is highly recommended to install the desktop software suite for your GNU/Linux distribution even
if you are installing GNU/Linux for a Harmony database server or a license server, as none of the
applications bundled with Harmony have been tested to work in a minimal environment on
GNU/Linux.
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Installing Harmony Dependencies on GNU/Linux

On GNUJ/Linux, Harmony requires the following packages to be installed:
« SDL
e 1libX1l1
e libXext
e libXrandr
e alsa-1lib
e libvorbis
e libsSM
e fontconfig
e libGLU
e libjpeg
e libpng
e 1libXi
e tcsh

¢ redhat-1sb

If you have a GNOME Desktop-type installation, most of these will be already installed, but at least some of
these will usually need to be installed manually. If you have a minimal installation, all of these packages will need
to beinstalled manually.

How to install the Harmony dependencies on GNU/Linux

1. Open aterminal and type in the following command.

sudo yum install SDL 1libX1l1l libXext libXrandr alsa-1lib libvorbis
libSM fontconfig 1ibGLU libjpeg libpng libXi tcsh redhat-1sb

2. When prompted, confirm that you want to proceed with the installation.
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Installing Proprietary Video Drivers on GNU/Linux

Harmony requires that the official (proprietary) drivers for your video card are installed in order to properly use
OpenGL to preview your artwork and animation. However, CentOS and Red Hat Entreprise Linux come with a
free and open source adaptation of the driver for your graphic card, with which Harmony is likely to encounter

issues.

Some video drivers come as application packages that are already made to install on your system without a
hassle. In this case, all you need to do is obtain the driver from your video card chipset manufacturer and follow
the installation instructions. Some other video drivers are distributed as scripts that build the drivers into kernel
modules. These are more complicated to install and this topic will break down the process, which consists of the

five following steps:
1. Obtain the official video driver from your video card chipset manufacturer's website.
2. Install the utilities required to build the video driver as a kernel module.
3. Disable the default video driver bundled with your operating system.
4. Launch GNU/Linux in terminal mode.

5. Run the official video driver's installation script.

How to know the model of your video card

1. Open aterminal and type in the following command:
lspci | grep 'VGA compatible controller'
The utility will output a line in this format:
01:00.0 VGA compatible controller: <video card model>

With this information, you can search for the website of the chipset manufacturer on the Internet,

and obtain the proper drivers from it.

How to install the utilities required to build the video driver as a kernel module

1. Open aterminal and type in the following command:

sudo yum install "kernel-devel-uname-r == $(uname -r)" || sudo yum
install kernel-devel

This command wiill install the headers for your Linux kernel, which are required to build a kernel
module such as a video card driver. It tries the command for installing kernel headers for an old
kernel and, if that fails, the command for installing kernel headers for the latest version of the kernel,

to cover both cases.

2. Enter the following command to install the remaining dependencies:
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sudo yum install kernel-headers gcc make dkms acpid

How to disable the default drivers on GNU/Linux

1. First, we must obtain the name of the kernel module used by your video card. To do that, start by
getting the address used by your video card with this command:

lspci | grep 'VGA compatible controller'
The output will be in this format:
01:00.0 VGA compatible controller: <video card model>

The numbers before VGA compatible controller are the address of the video card. They
should be in the #4# : ## . # format. Make note of them.

2. Search the for module associated with this address by entering the following command. Replace
#4# : ## . # with the address used by your video card.

The output will look like this:
/sys/bus/pci/drivers/nouveau/0000:01:00.0

The name of the folder just under drivers is the name of the kernel module. In this example, it is
nouveau, Which is typically used for NVIDIA graphic cards.

3. Open the list of blacklisted kernel modules in a text editor:

sudo vi /etc/modprobe.d/blacklist.conf

4. Add the name of the kernel module for your video card to the list of blacklisted modules:

blacklist <name of kernel module>

For example, if the kernel module for your video card is nouveau, you would add the following line:

blacklist nouveau

5. Rebuild initramfs. With the default video driver added to the blacklist, initramfs will be
configured to exclude these drivers from the list of modules it loads on boot, and load the basic video
driver instead:

sudo mv /boot/initramfs-$ (uname -r).img{,~}
sudo dracut -v /boot/initramfs-$ (uname -r).img $ (uname -r)

6. Reboot the machine.

27



Chapter 1: Basic Installation

NOTE

After rebooting, it is possible that your display resolution will no longer be optimal. This
is a sign that you successfully disabled the default video driver. Your display resolution
will be optimal again after you install the proprietary video driver.

7. After logging in, you can verify that the default video drivers are no longer loaded by running the
following command.

lsmod | grep "<name of kernel module>"

For example, if the kernel module for your video card was nouveau, you could use the following
command:

lsmod | grep "nouveau"

If it returns nothing, GNU/Linux is now running on basic video drivers that will not interfere with the
installation of proprietary drivers.

How to launch GNU/Linux in terminal mode and run the driver installation utility

1. Reboot your machine.

2. Atthe GNU GRUB boot menu, use the Up and Down arrow to move the cursor to the boot menu
entry that you usually use to boot GNU/Linux.

3. PresstheE key.

GRUB opens the selected entry in a text editor, allowing you to temporarily modify its parameters
for this boot cycle only.

NOTE

The changes you make to the boot menu entry will only affect this launch and will not be
preserved next time you boot the machine.

4. Using the Up and Down key, move the cursor to the line that starts with kernel or 1inux16.
5. Use the End key to move the cursor to the end of that line.

6. Add a space at the end of the line, followed by 3. This is a boot parameter that will instruct
GNU/Linux to boot at run level 3, which means it will load a simple terminal with networking
capabilities.

7. Press Ctrl + X.
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10.

11.

12.

GNU/Linux will begin booting. At the end of the process, you will be presented with a simple
terminal and prompted to log in by typing your username and password.

Log in with the username and password of a user with administrative privileges.
Navigate to the directory in which you downloaded the driver installation utility.
cd ~/Downloads
Add execute permissions to the utility.
chmod +x ./path to_driver installer.run
Run the utility.
sudo ./path_to_driver installer.run

Follow the instruction to install the driver. If the installation is successful, the driver will be loaded
next time you boot GNU/Linux.
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Installing Harmony on GNU/Linux

Toinstall Harmony on GNU/Linux, you must extract the package from the .tar.gz archive you downloaded, then

run the installation script it contains.

You can choose to run the installation script interactively or with command line parameters to automate most of
the process.

NOTES

« If youwant to run the installation script interactively, your operating system must have the
whiptail command line tool, which is provided with the newt application package.

« Even if youinstall Harmony non-interactively, you must still interactively review and agree to
the license agreement on each installation.

How to install Harmony on GNU/Linux interactively

1. Verify that whiptail is present on your system, to allow the installer to use interactive mode:
sudo yum install newt

2. In aterminal, navigate to the directory where you downloaded the installation package.
cd ~/Downloads

3. Extract the package's contents in the directory.
tar -xvzf ./name-of-package.tar.gz

4. Switch tothe directory in which the package's contents were extracted.
cd name-of-package

5. Run the install script.
sudo ./install

The interactive setup launches in the terminal.

6. Do one of the following:

o Ifyouare working in a Harmony Server environment, whether your machine is going tobe a
client workstation or a server, select SERVER and press Enter.

o Ifyouare working in a fully standalone environment or if you only intend to connect to a
Harmony database using WebCC, select STANDALONE and press Enter.

7. Inthe components dialog, for each component you want to install, use the Up and Down keys to
highlight the component, and the Spacebar key to check or uncheck the component:
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o APPLICATION: Installs the application files: binaries, libraries, resources, configuration files,
etc. Thisis required to be able to launch Harmony. You should only omit this option if you are
using the installer to add components to an existing installation. .

o DESKTOP: Creates a directory in the Applications menu of your desktop environment and
adds a shortcut for each Harmony application inside it. This option also allows you to open a
scene in Harmony by double-clicking on an . xstage file in a file browser.

o PATH: Adds the path to the Harmony binaries to your SPATH environment variable,
allowing you to launch Harmony applications from a terminal by typing their name instead of
their full path.

o URL: Registers the harmony:// URL scheme so that such URLs launch Harmony. This allows
WebCC clients to launch Harmony directly from the web browser.

If you selected to install Harmony Server, these options will also be available:

o« PROCESS: Enables the batch processing daemon and adds the current machine to the
database's list of machines available for batch processing.

NOTE

Further configuration is required to make this machine a working batch
processing node.

o« DATABASE: Enables the database server daemon and, if no database is present on the
machine, creates an empty database file system on the local machine.

o LINK: Enables and configures the link server daemon. This is required if the current machine
is meant to be a database server for Windows clients.

« WEBCC: Enables and configures the WebCC daemon. This will make this machine a WebCC
server.

o OPENH264: Downloads and installs the Cisco OpenH264 library. This allows a WebCC
server to create preview videos for the database scenes which can be played in a web
browser. An Internet connection is required.

« UPDATEDB: Replaces the dictionary (.dict) files in this machine's database with this
package's dictionary files. This is useful if your machine is a database server, and you are
currently upgrading its version of Harmony.

8. Pressthe Tab key to switch to the Ok button at the bottom, then press Enter.

9. Inthe Installation Directory dialog, you can choose to type a custom installation path, or to use the
default one. Then, press Enter.
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10. Inthe License Agreement dialog, take the time to carefully review the license agreement. Use the
Up and Down keys to scroll through the text in the agreement and read it until the end.

11. Press Tab to switch tothe AGREE and DISAGREE buttons. You can use the Left and Right keys to
switch between selecting the AGREE or the DISAGREE button:

o Ifyouagree with the license agreement, select the AGREE button and press Enter.

« Ifyoudisagree with the license agreement, select the DISAGREE button and press Enter.

12. A dialog will prompt you to confirm each component that you elected to install. If a lot of components
are listed, you can use the Up and Down keys to scroll through the list. You can use the Left and
Right keys to select Yes or No. If you want to proceed, select Yes and press Enter.

13. Theinstallation begins. Each step of the installation is explained in detail until the installation is

over.
14. Ifyour product is not activated, do one of the following to launch the License Wizard:

e In the terminal, type the following command:

sudo /usr/local/ToonBoomAnimation/harmony[Edition]_ 17/1nx86
64/bin/LicenseWizard

o Inthe GNOME top menu, select Applications > Harmony 17 [Edition] > License Wizard.

A terminal will open, prompting you to enter your user password. This terminal is attempting
to launch License Wizard with sudo, as it requires elevated privileges. Type in your password
and press Enter.

For information on how to use the License Wizard to activate Harmony, see the Toon Boom License
Activation Documentation at the following address:

https://docs.toonboom.com/help/activation

15. Once Harmony isinstalled and activated, you can start using it. However, if you elected to add the
path to Harmony's binaries to your $PATH environment variable, you will need to reboot your
machine before you can benefit from this feature.

How to install Harmony on GNU/Linux non-interactively

1. Inaterminal, navigate to the directory where you downloaded the installation package.
cd ~/Downloads
2. Extract the package's contents in the directory.

tar -xvzf ./name-of-package.tar.gz
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3. Switch to the directory in which the package's contents were extracted.
cd name-of-package
4. Start typing the command to run the installer with all the parameters you want for your installation:

sudo ./install <parameters>

NOTE
Each parameter must be specified separately. For example: —a -p will work, but not -
ap.

Parameter Description

Installation modes

Installs the application with shortcuts to the server applications and with
daemon files for database servers and clients.

9} NOTE

If no installation mode is specified, this one is implied by default.

-server

Installs the application without the shortcuts to the server applications

tandal and without the daemon files for database servers and clients. Only use
-standalone
this option if you intend to use Harmony on this machine without relying

on a Harmony Server database.

install Uninstalls the specified components instead of installing them. If
-uninsta
specified alone, this launches the uninstaller in interactive mode.

Optional components

Installs the application files: binaries, libraries, resources, configuration

-a files, etc. This is required to be able to launch Harmony. You should only
-application omit this option if you are using the installer to add components to an
existing installation. .
b For backward compatibility with older versions of the installer, this

installs the application files and adds the path to the Harmony binaries to
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Parameter

Description

-binaries the $PATH environment variable. It is equivalentto -a -e.
-de Creates a directory in the Applications menu of your desktop
environment and adds a shortcut for each Harmony application inside it.
-desktop . . .
This option also allows you to open a scene in Harmony by double-
-kde clicking on an .xstage file in a file browser.
-d Enables the database server daemon and, if no database is present on
_dbserver the machine, creates an empty database file system on the local machine.
-l Enables and configures the link server daemon. This is required if the
_linkserver current machine is meant to be a database server for Windows clients.
Enables the batch processing daemon and adds the current machine to
the database's list of machines available for batch processing.
-p
NOTE
-process
Further configuration is required to make this machine a working
batch processing node.
W Enables and configures the WebCC daemon. This will make this machine
-webccserver a WebCC server.
_oh Downloads and installs the Cisco OpenH264 library. This allows a
WebCC server to create preview videos for the database scenes which
-openh264

can be played in a web browser. An Internet connection is required.

Configuration switches

-env

Adds the path to the Harmony binaries to your SPATH environment
variable, allowing you to launch Harmony applications from a terminal by
typing their name instead of their full path.
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Parameter

Description

-S

-schemeregister

Registers the harmony:// URL scheme so that such URLs launch
Harmony. This allows WebCC clients to launch Harmony directly from
the web browser.

Replaces the dictionary (.dict) files in this machine's database with this

-u
package's dictionary files. This is useful if your machine is a database
-updatedict server, and you are currently upgrading its version of Harmony.
Other options
-h
Displays information about how to use the install script.
-help
Specifies the directory in which to install the application. If not specified,
-target <PATH> Harmony will be installed in /usr/local/ToonBoomAnimation/harmony

[Edition)_17

-dbpath <PATH>

Specifies the location of the database on this machine's file system. This
option is only relevant if installing a database server with the -d option,
installing a WebCC server with the -w option or updating dictionary
(.dict) files with the —u option. If not specified, the installer will presume
that the database is located in /JUSA_DB.

-own

-own <USER>

-own <USER:GROUP>

Makes the application files owned by the specified user or by the
specified user:group. If no user or user:group is specified, this will make
the application files owned by the user running the script. If this option
is not specified, application files will be owned by the root user.

-q
Do not output information during the installation process.
-quiet
v Output detailed information on each step of the installation process,
_verbose including every file copied.
-output <PATH> Writes the installation log to the specified file instead of outputting it to
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Parameter

Description

the terminal.

-nodialog

Disables the use of the whiptail utility to display dialogs and
interactive prompts. This mode is compatible with dumb-type terminals,
which do not support scrolling or erasing the screen.

NOTE
This option is automatically enabled if the whiptail utility is
not found on the machine or if the installer detects that the
terminal is unable to scroll or erase the screen.
By default, installing over an existing installation will simply overwrites
existing files, except for configuration files in the etc directory of the
installed application, which the installer preserves. This option will cause
the existing installation to be completely deleted before installing.
-force
@ IMPORTANT
Enabling this option will cause your Harmony configuration files
to be erased permanently.
-y
Assumes yes on all prompts, except for the license agreement.
-assumeyes

Press Enter.

The install script launches and, if the parameters are valid, the License Agreement prompt appears.

In the License Agreement dialog, take the time to carefully review the license agreement. Use the
Up and Down keys to scroll through the text in the agreement and read it until the end.

Press Tab to switch to the AGREE and DISAGREE buttons. You can use the Left and Right keys to
switch between selecting the AGREE or the DISAGREE button:

« Ifyou agree with the license agreement, select the AGREE button and press Enter.

« If youdisagree with the license agreement, select the DISAGREE button and press Enter.

A dialog will prompt you to confirm each component that you elected to install. If a lot of components
are listed, you can use the Up and Down keys to scroll through the list. You can use the Left and
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9.

10.

11.

Right keys to select Yes or No. If you want to proceed, select Yes and press Enter.

The installation begins. Each step of the installation is explained in detail until the installation is

over.

If your product is not activated, do one of the following to launch the License Wizard:

e Inthe terminal, type the following command:

sudo /usr/local/ToonBoomAnimation/harmony[Edition]_17/1nx86
64/bin/LicenseWizard

e Inthe GNOME top menu, select Applications > Harmony 17 [Edition] > License Wizard.

A terminal will open, prompting you to enter your user password. This terminal is attempting
to launch License Wizard with sudo, as it requires elevated privileges. Type in your password

and press Enter.

For information on how to use the License Wizard to activate Harmony, see the Toon Boom License
Activation Documentation at the following address:

https://docs.toonboom.com/help/activation

Once Harmony is installed and activated, you can start using it. However, if you elected to add the
path to Harmony's binaries to your $PATH environment variable, you will need to reboot your

machine before you can benefit from this feature.
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Adding Harmony Binaries to the SPATH Environment Variable on
GNU/Linux

You can add the path to the Harmony binary files to the $PATH environment variable. This will allow you to run
Harmony and its applications and utilities from a terminal by typing the name of the executable files, without
having to type their full path.

How to add Harmony binaries to the SPATH environment variable on GNU/Linux

1. InaTerminal, navigate to the location where you previously extracted the Harmony package for
installation—see Installing Harmony on GNU/Linux.

cd ~/Downloads/name-of-package

2. Run the installation script with the -e option.

sudo ./install -e
The Toon Boom Harmony license agreement prompt appears.

3. Inthe License Agreement dialog, take the time to carefully review the license agreement. Use the
Up and Down keys to scroll through the text in the agreement and read it until the end.

4. Press Tab to switch tothe AGREE and DISAGREE buttons. You can use the Left and Right keys to
switch between selecting the AGREE or the DISAGREE button:

« If you agree with the license agreement, select the AGREE button and press Enter.

« If you disagree with the license agreement, select the DISAGREE button and press Enter.

5. A dialog will prompt you to confirm that you want to add the path to the Harmony binaries to the
$PATH environment variable. You can use the Left and Right arrow keys to select Yes or No. Select
Yes and press Enter.

The install script will add the path to the Harmony binaries to the $PATH environment variable.

6. To verify that the change has been applied, open a new Terminal window and type the following
command:

echo $PATH

The path to the Harmony bin folder should be included in the output, separated by other paths
with a colon.
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About Audio Transcoding on GNU/Linux

On GNUJ/Linux, by default, Harmony can only play audio files with these specifications:
o Format: Waveform Audio File (.wav)
o Sample rate: 22 050 Hz
o Sample size: 16 bits
« Channel mode: Stereo

If FFmpeg is installed on your system, Harmony will use it to transcode other audio formats into this format on
the fly. However, FFmpeg comes bundled with patented algorithms such as encoders and decoders, the
unlicensed use of which may contravene intellectual property laws in your jurisdiction. Hence, if you use
Harmony on GNU/Linux, it is recommended to transcode your audio in the format specified above using third-
party software before importing it to your Harmony scene.
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Preventing the Alt Key Keyboard Shortcut Conflict Between Harmony
and the GNU/Linux Desktop

By default, in GNOME 2 and KDE, clicking anywhere on a window while holding the Alt key down will move
the window. Because the Alt key is used as a modifier for some drawing and animations tools in Harmony, this
may come in conflict with Harmony functionalities. Hence, it is highly recommended to configure your desktop
environment to use the Super (Windows) key for moving windows instead.

How to change the window moving keyboard shortcut in GNOME 2

1. Inthe GNOME top menu, select System > Preferences > Windows.
The Window Preferences dialog appears.
2. Inthe Movement Key section, select Super (or "Windows Logo")

3. Click on Close.

How to change the window moving keyboard shortcut in KDE

1. Inthe KDE menu, select Computer > System Settings.

2. Inthe System Settings window, select the Windows Behavior icon.
3. Select the Window Actions tab.

4. In the Modifier Key drop-down, select Meta.

5. Click on Apply.
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Troubleshooting Problems with Harmony on GNU/Linux

The following section explains how to fix common issues with Harmony on GNU/Linux.
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Troubleshooting a Crash When Loading Harmony on GNU/Linux

If Harmony crashes when opening a scene or proceeding to the offline welcome screen, returning the message
"segmentation fault" tothe terminal, this may be caused because Harmony is not compatible with later
versions of OpenSSL. You can fix this by setting the OPENSSL_ia32cap environment variable to the value
"~0x200000200000000". This can be done in three different ways:

« Setting the environment variable in a terminal and launching Harmony from this terminal.

TIP

You should attempt this first to make sure that setting this environment variable actually
solves the problem.

o Setting the environment variable for one user, and launching Harmony when logged in as this user.

« Setting the environment variable for the entire machine, allowing you to launch Harmony as any user.
This requires an account with administrator privileges.

How to set the OPENSSL_ia32cap environment variable in a terminal and launch
Harmony

1. Open aterminal and enter the following command:
export OPENSSL ia32cap="~0x200000200000000"
2. Launch Harmony from the same terminal:

/usr/local/ToonBoomAnimation/harmony[Edition]_17/1nx86_
64/bin/Harmony [Edition]

How to set the OPENSSL _ia32cap environment variable for the current user

1. Open aterminal and open your Bash shell login file:
vi ~/.profile
2. Add the following line at the end:
export OPENSSL ia32cap="~0x200000200000000"
3. Save and quit.
4. Open your C-shell login file:
vi ~/.login

5. Add the following line at the end:
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setenv OPENSSL ia32cap "~0x200000200000000"
6. Save and quit.
7. Log out, then log back in.

8. Attempt to launch Harmony.

How to set the OPENSSL _ia32cap environment variable for all users

1. Create a new Bash boot script using the following command:

sudo vi /etc/profile.d/openssl.sh

2. Inthe script, type the following command:

export OPENSSL_ ia32cap="~0x200000200000000"
3. Save and quit.

4. Create a new C-shell boot script using the following command:

sudo vi /etc/profile.d/openssl.csh

5. Inthe script, type in the following command:

setenv OPENSSL ia32cap "~0x200000200000000"
6. Save and quit.
7. Reboot the machine.

8. Attempt tolaunch Harmony.
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Troubleshooting Desktop Shortcuts Launching the Wrong Version of
Harmony

If you have several older versions of Harmony installed, it is possible that some of their shortcuts launch the
wrong of Harmony. This is because, prior to Harmony 15.0, desktop shortcuts created for Harmony would not

point to the full path of applications, so they launched the version of the application in the $PATH environment
variable.

A script has been made to fix this issue. It will go through every installation of Harmony in the default
installation location and create shortcuts for them with the proper configuration.

You can download the script from the following location:

https://docs.toonboom.com/download/tools/fix_harmony_shortcuts.sh

NOTE

This script will only work for installations of Harmony that are located in the default directory:
/usr/local/ToonBoomAnimation.

How to launch the desktop shortcut fixing script

1. Inaterminal, gotothe directory where you downloaded the script.
cd <download directory>

2. Add execution privileges to the script.
chmod +x fix harmony shortcuts

3. Run the script with elevated privileges:
sudo ./fix_harmony_ shortcuts

4. Read the confirmation prompt, then type yes and press enter.
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Chapter 2: Harmony Server

Harmony Server is a team-based infrastructure for animation production. Its array of cutting-edge features
increases productivity and encourages creativity. Developed in conjunction with leading studios worldwide,
Harmony is specifically designed for long-term episodic and feature length projects, providing a true animation
pipeline. Several animators can work simultaneously on the same scene while the asset library provides users
with easy access to up-to-date media assets.

Harmony Server is truly scalable; more than 100 staging clients can share animation just as easily as a few can.
Whether you are a start-up studio or a large established animation facility, Harmony serves as the animation
backbone ensuring sustainability and growth.

Harmony Server is a powerful solution that brings together multiple teams working on the same project,
whether in-house or remotely. The Harmony Serversolution offers a robust asset management system that
enables users to quickly locate assets, share tasks on complex scenes and centralize all assets in a common
repository. Tremendous gains in efficiency and quality are made by the teams, who enjoy a smooth flow
between each task, and more time dedicated to their creative assignments.

In addition, the server is critical at the end of a production for rendering projects efficiently. The rendering
process, controlled directly by the server, not only renders production scenes but also executes the batch
vectorization of the scanned drawings. You can send an unlimited number of scenes to render and change their
priorities depending on your deadline. You can also render final frames locally or batch process over a network
in the background or at scheduled times. For more information, see Batch Processing on page 282.
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About the Harmony Server Structure

The primary purpose of the database server is to host and manage the information on its Harmony scenes.
Optionally, it can also host the actual scene data, but other machines on your network can be used for scene
data storage as well, as those are two different components of a Harmony database.

A Harmony database is structured using different network shares:

« The /USA_ DB share, which contains the information on all the scenes, environments, jobs as well as
shared assets such as palettes and templates stored in environments or jobs. This part of the database
must be hosted on the machine that runs the database server service/daemon, to which client
workstations will connect directly.

o /usadata shares, which contain the actual scene data: the drawings, animation, 3D models, scene
palettes, etc. Those can be hosted on the database server or on any machine on the local network that
the client workstations can access. There can be as many as the studio needs, which allows you to
expand the storage capacity of your database server by creating a new /usadata share on a new file

server.

On client machines, every network share is mounted on the same location as the location of the actual share on
their respective server. Likewise, if other servers are used to store scene data, the shares of these servers are
mounted on the database server. The result is that the database file structure is entirely accessible on all
machines in the network.

If you intend to use several /usadata shares, they must be numbered them. The best practice is to name the
first /usadata share /usadata000, and it is typical, although not mandatory, to store that share on the same
machine as the database server. Then, when you need to expand the storage space for your Harmony
database, you can create a share named /usadata001 on another machine, and another one named
/usadata002 on another machine, etc.

In the end, client machines will locate the different shares that compose your database by mounting those
share points on the client machine's filesystem root.

On Windows machines, this is done by adding shortcut (.Ink) files in the root of a drive (typically C:) which point
to the network path of the share, for example:

o AUSA DB.1lnk shortcut file pointing to \\dbserver\USA DB.
e Ausadata000. 1nk shortcut file pointing to \\dbserver\usadata000.
o Ausadata001l. 1lnk shortcut file pointing to \\newfileserver\usadata0OO01l.

This process is automatically done by Configuration Wizard, a Windows-exclusive configuration tool for
Harmony.

On macOS and GNU/Linux machines, this is done by mounting the shares on folders located at the root of the
filesystem. By giving those folders the name of their respective shares, it simulates the presence of the server's
files on the machine's filesystem. For example:
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« Adirectory named /USA_DB is mounted with the NFS share at address dbserver: /USA_ DB.

o A directory named /usadata000 is mounted with the NFS share at address

dbserver: /usadata000.

o A directory named /usadata001 is mounted with the NFS share at address

newfileserver:/usadata001.

Typically, clients and servers can communicate without any issue if they use the same kind of operating system.
It is possible to set-up a Harmony database that mixes different platforms across the database server, the file
servers and the client workstations, but with some important limitations that must be taken in account:

« By default, the use of non-alphanumerical Unicode characters, with the exception of the dash and the
underscore, in Harmony for naming scenes, layers and drawings is not enabled, but can optionally be
enabled. However, you must absolutely keep in mind that macOS and GNU/Linux typically fail to
communicate filenames containing Unicode characters over the NFS protocol. This means that if
Unicode is enabled on your database, and that a macOS based client tries to open or save a scene
containing Unicode characters which is hosted on a GNU/Linux-based file server, Harmony will fail to
open and save files with Unicode characters in their name, and there might be data loss! Hence, it is
important to never enable Unicode if your network includesmacOS-based clients and GNU/Linux-based
database servers or file servers, including GNU/Linux-based NAS servers.

« Ifyou set up your database server on a Windows machine, only Windows clients are supported. It may
be possible to connect a macOS-based or GNU/Linux-based client workstation to a Windows-based
database server, but this may cause unexpected issues and it is not a supported usage scenario.

o Ifyouintend to set up your database server on a macOS machine and you want Windows workstations
to be able to connect to it, you will need to install a third party software, SMBup, and configure it to
share your database files through the Samba protocol. This is because macOS natively supports the NFS
sharing protocol, but not SMB, and Windows natively supports the SMB file sharing protocol, but not
NFS.

To summarize, here is a table outlining the implications of mixing platforms between servers and clients:

| Client

GNU/Linux

Requires SMBup to be
Windows No problem. installed and configured No problem.
on the server.

Unicode must be

macOS Not supported. No problem. .
disabled.

. Unicode must be
GNU/Linux Not supported. . No problem.
disabled.
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About Database Server Installation

At the heart of the Harmony Server solution is the server itself, which centralizes all the production assetsin a
repository. Loaded with production proven tools to manage administration tasks, the server is completely
flexible and will fit in with your existing infrastructure, whether you're on Windows, Mac or Linux.

The first step to having a Harmony Server network is to set up the database server. The database server
contains the structure of the database and runs a programs that allows client workstations to open and edit
scenes remotely.

Installing a database server can be done on all platforms supported by Harmony: Windows, macOS and
GNU/Linux. Although the installation procedure is substantially different on each platform, they all have the
same basic components:

« Creating a database file structure and a scene data storage space.

« Sharing the database files using the Samba (Windows) or NFS (macOS or GNU/Linux) file-sharing
protocol, so that other machines can access them.

« Configuring the database server program, which handles client requests, to run on startup or login.

Because of the differences in the way Windows and UNIX filesystems work, and in the way Windows, macOS
and GNUY/Linux support filesharing, extra steps are required if you need to allow Windows clients to connect to
a macOS or GNU/Linux-based server, mainly:

« Sharing the database files using the Samba file-sharing protocol.
o Configuring the link server program, which handles the creation of symbolic links for Windows clients.

Additionally, it may be required to add security exceptions to the server machine's firewall for the database
server, the link server and the file sharing services used by the server.

Optionally, a server machine's firewall can be fully disabled to allow open communications between different
machines on the site. However, a dedicated firewall should be set-up at the site level to ensure computers
outside of the site cannot attack machines on the site.

IMPORTANT

Although it may be possible to use macOS or GNU/Linux based client workstations to connect to a
Windows based database server, this is not a supported usage scenario and attempting this may
cause unexpected problems.

49



Chapter 2: Harmony Server

Database Server Installation on Windows

On Windows, the basic setup for a database server is done through the Configuration Wizard, which will
create the base structure of the database and automatically configure the database server service.

Disabling the Firewall for a Harmony Database Serveron Windows ... ... .. ... ... ... ... 51
Setting up the Database Serveron Windows .. 52
Removing the Scene Data Storage from the Database Serveron Windows ................. ... ... ........... 54
Running the Database Server Service on Log-Inon Windows ... . 55
Opening the Firewall Ports for a Harmony Database Serveron Windows ... ... ... ... ................. 57
Creating a Scene Data Storage Space on Windows . .. 59
Configuring a Windows Database Server to have a StaticIP Address ... ... .. . . ... 65
Looking Up the Database Server Log on Windows .. L 69
Launching the Database Server Manually on Windows ... . 70
How to Stop and Restart the Database Server on Windows ... ... ... 71
Pausing and Resuming the Database Serveron Windows .. ... lllll..... 73
Uninstalling the Database Server on Windows . 74
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Disabling the Firewall for a Harmony Database Server on Windows

By default, the Windows firewall will block incoming connections to a database server. This installation guide
provides instructions on how to add exceptions for the database server to your firewall. However, you may
prefer to disable the firewall completely so as to simplify the installation process or to rule out the firewall as a
possible cause when troubleshooting an issue.

@ IMPORTANT

If you choose to disable the firewall on Windows, it is critical to ensure that your domain has
effective site-wide security measures to prevent unauthorized access to your database server.

How to disable the firewall on Windows

1. Open the Windows Control Panel:

o On Windows 7: Open the Start menu and select All Programs > Accessories > System
Tools > Control Panel.

o On Windows 8.1 or Windows 10: Open the Start menu and, in the programs list, select
Windows System > Control Panel.

2. Inthe Control Panel, select System and Security.

3. Under Windows Defender Firewall, select Check firewall status.

4. Inthelist to the left, select Turn Windows Defender Firewall on or off.

5. Under Domain network settings, select Turn off Windows Defender Firewall (not recommended).
6. Under Private network settings, select Turn off Windows Defender Firewall (not recommended).
7. Under Public network settings, select Turn off Windows Defender Firewall (not recommended).

8. Click on OK.
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Setting up the Database Server on Windows

Using the Toon Boom Harmony Configuration Wizard, you can quickly create the basic structure for a Harmony
database and install the database server as a Windows service, which will run as user usabatch.

How to set up a Harmony database server on Windows

1. Inthe Start menu, open the Programs menu and select Harmony 17 [Edition] > Tools > |E
Configuration Wizard.

2. When prompted, enable Configuration Wizard to make changes to your device.
The Toon Boom Harmony Configuration Wizard launches.
3. Inthelist of tasks, right of Database, click on the ... button.
4. Inthe Toon Boom Harmony Database Creation dialog, select Server/Standalone and click on Next.

5. Under What drive should be used for the database?, select which drive on this machine should be

used to store the database's files.

NOTE

A USA DB directory will be created at the root of the selected drive.

6. Under What is the UserName?, type in the username of the user account you want to create for the
database server service. This will create a local user account on your Windows machine, and this
user will be connecting to the network and running the service. By default, this use is named
usabatch.

TIP

If you already configured a user for a database server or the batch processing service on
this machine before, you can type in the name of that existing user. The Configuration
Wizard will use this existing user account to run the database server service instead of
creating a new one.

7. Under What is the User Password?, type in the password for the user that will run the database
server service. If you are creating a new user, use this field to select their password. If you typed in
the user name of an existing user account, type in their actual password.

8. Click on Next.

The Scene Data Location dialog appears. In this dialog, you can create a scene data storage on this
machine. By default, this dialog is already configured to add a single scene data storage to this
machine, on the drive C, named usadata000.
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9.

10.

11.

In the User Name and Password fields, make sure the credentials for the scene data location that
will be created on your machine match the ones entered for the database server, typed in steps 5
and 6.

Click on Next.

In the Database changes field, verify that that the changes the wizard is about to make are correct,

then click on Finish.

Your database is set-up. At this point, you should already be able to run Control Center from this
machine, log-in with the default user usabatch and create scenes and users.

53



Chapter 2: Harmony Server

Removing the Scene Data Storage from the Database Server on
Windows

By default, Configuration Wizard will add a scene data storage space to the server when creating a database
server. If you want all of the scene data storage spaces to be on other machines than the database server

machine, you must first remove that storage space from the server, then create a scene data storage space on
another machine.

How to remove the scene data storage space from a Windows database server

1. Open an Explorer window.

2. Navigate to the root of the drive in which the scene data storage space was created. By default, this
driveisC:.

3. Select the directory usadata000.

4. Delete this directory.

5. Open the Start menu and, in the Programs list, select Windows Accessories.

6. Right-click on Notepad and select Run as Administrator.

7. Inthe top menu of Notepad, select File > Open.

8. Inthe Open dialog, select All Files (*.¥) in the file type drop-down in the bottom-right corner.

9. Browse to and select the following file:

C:\Program Files (x86)\Toon Boom Animation\Toon Boom Harmony 17
[Edition] \etc\server.ini

In the file, there are numerous lines starting with FileSystem. The first one of them will most likely
contain information about the scene data storage space the Configuration Wizard created. For
example, if the name of the server is harmonyserver, this line would contain:

FileSystem0=C usadata000 harmonyserver

10. On thisline, remove all of the information after the equal sign for FileSystem0:
FileSystemO=

11. Inthe top menu, select File > Save.

The storage space has now been removed from your database server. To create another storage
space on a different machine, see Creating a Scene Data Storage Space on Windows.
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Running the Database Server Service on Log-In on Windows

When creating a database server with Configuration Wizard, the database service is configured to launch as
an actual Windows service. This means it launches and allows clients to connect as soon as the machine is
booted, without any user being signed-in.

Using Service Launcher, it is possible to configure your database server to only launch its database server
service as the logged-in user, when they log-in. This means the database will only be accessible if the user
configured to run it is logged in.

Although this may seem impractical, it may be preferable for security reasons. Services installed with the
Configuration Wizard are run under the user usabatch, an user with administrator privileges which is created
by Configuration Wizard to launch the services. When using Service Launcher, the logged-in user does not
need to have administrator privileges to run services.

Before configuring Service Launcher to run the database server, the windows service that launches it must be
disabled, so as to avoid launching two instances of the database server.

NOTE

While Windows services run regardless of who is logged in and even when no user is logged-in,
Service Launcher will only run when the user for which it was specifically configured is logged in.
This means that if you want Service Launcher to launch when any user is logged in, you must
configure it for each user that has access to the machine.

How to disable the database server service

1. Open the Start menu and, in the Programs menu, select Harmony 17 [Edition] > Tools > m
Control Panel.

2. When prompted, allow Control Panel to make changes to your device.

3. Inthe Process Starter drop-down, select HarmonyStarterO-tbdbserver.

NOTE

The number after HarmonyStarter may be different, depending on how many Harmony
services were installed before this one.

4. Click on Stop.
5. Click on Remove.
From that point on, the database server service will no longer launch on boot.

6. Close the Control Panel.
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How to configure the database server to launch on user log-in

1. Make sure you are currently signed-in as the user who will run the service.

NOTE

This user will need to be logged in for the service to be running. The user does not need
to have administrator privileges.

2. Doone of the following:

« If Service Launcher is not running, open the Start menu and, in the Programs list, select
Harmony 17 [Edition] > Tools > Service Launcher.

« If Service Launcher is already running, click on its icon m in the notification tray.
The Service Launcher application launches.

3. Inthe Application parameters section of the Preferences tab, make sure that the Launch on login
option is checked, so that services configured in Service Launcher automatically launch when you log
in to your account.

4. Select the Database Server tab.

5. Click on Launch to verify that the database server launches successfully through Service Launcher.
6. Check the Launch when Service Launcher starts option.

7. Inthe top menu, select Server > Save All Settings.

From now on, the database server will launch through Service Launcher when you log in.
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Opening the Firewall Ports for a Harmony Database Server on
Windows

By default, the Windows firewall will block the communication between client workstations attempting to
connect to the Harmony server and the database server service. In order to allow clients to connect to your
server, you must open the ports used by the database server on the server machine.

How to open the ports for the Harmony database server on Windows

1. Open the Windows Control Panel:

o On Windows 7: Open the Start menu and select All Programs > Accessories > System
Tools > Control Panel.

e On Windows 8.1 or Windows 10: Open the Start menu and, in the programs list, select
Windows System > Control Panel.

2. Click on System and Security.
3. Click on Windows Defender Firewall.
4. Click on Advanced settings.
The Windows Defender Firewall with Advanced Security window opens.
5. Inthelist to the left, select Inbound Rules.
6. Inthe Actions list to the right, select New Rule.
The New Inbound Rule Wizard appears.
7. Under What type of rule would you like to create?, select Port and click on Next.
8. Under Does this rule apply to TCP or UDP?, select TCP.
9. Under Does this rule apply to all local ports or specific local ports?, select Specify local ports.

10. Inthe text field, type the port number 5680.

NOTE

Thisis the default port used by the Harmony database server. However, the port
number for the database server can be customized by editing the Dbserver. conf file
located in /USA_DB.

11. Click on Next.

12. Under What action should be taken [...], select Allow the connection and click on Next.
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13.

14.

15.

Under When does this rule apply?, check the network types over which clients will attempt to
connect to this server, then click on Next.

In the name field, name the rule "Toon Boom Database Server".
Click on Finish.

Clients on your network will now be able to communicate with the database server.
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Creating a Scene Data Storage Space on Windows

You can create additional storage spaces for your Harmony database on different Windows machines. The
database server will connect to these machines to transmit scene data to the clients, allowing you to expand
the storage capacity of your database.

The first step is to create a shared folder on the Windows machine that will host the new storage space. Then,
you must configure your database server with the information about this new storage space so that, when
using Configuration Wizard to set up new Harmony Server clients, this new share will be added to the client
configuration. Lastly, if you want the database server itself to have access to the new storage space, you must
add a shortcut to that storage space's network path on the database server.

If you intend to configure your database server and the scene data storage spaces to require credentials to be
accessed, you should configure all the shares to be accessible with the same user names and password, as
Harmony clients will only use one set of credentials to connect to the database and the different scene data
storage spaces. For example, in an open network environment, it is typical to give access to all the Harmony-
related network shares to the user usabatch.

How to create the user usabatch on a new Windows-based scene data storage server

1. Open the Windows Control Panel:

o On Windows 7: Open the Start menu and select All Programs > Accessories > System
Tools > Control Panel.

o On Windows 8.1 or Windows 10: Open the Start menu and, in the programs list, select
Windows System > Control Panel.

2. Inthe Control Panel, click on System and Security.
3. Inthe System and Security panel, click on Administrative Tools.
4. Double-click on Computer Management.

5. In the Computer Management dialog, in the navigation tree to the left, select Local Users and
Groups > Users.

6. Inthe Actions panel to the right, select More Actions > New User.

7. Inthe New User dialog, enter the desired credentials for the user that will be used to access the
network share. For example:

o User name: usabatch
e Full name: usabatch
o Password: usabatch

o Uncheck the User must change password at next logon option.
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8.

o Check the User cannot change password option.
o Check the Password never expires option.

Click on OK.

How to create a scene data storage space on Windows

10.

11.

12.

13.

14.

15.

Log-in to the machine that will be used as the new scene data storage space using an account with
administrator privileges.

Open an Explorer window.
Browse to the root of the drive where you want the scene data to be stored (ie: C:).
Create a new directory.

Name the directory usadata, followed by a padded, zero-based number indicating itsindex in the
list of storage spaces used by yourHarmony database. For example, if this is the second storage
space your add to your database, name it usadata001.

Right-click on the folder and select Properties.

Open the Sharing tab.

Click on Advanced Sharing.

In the Advanced Sharing dialog, check the Share this folder checkbox.
Click on Permissions.

In the Group or user names list, select Everyone.

Check the checkbox right of Full Control, under the Allow column.
Click on OK.

In the Advanced Sharing dialog, click on OK.

In the Properties dialog, click on Close.

How to add the a new scene data storage space to your server configuration

Log in to the database server.
Open the Start menu and, in the Programs list, select Windows Accessories.
Right-click on Notepad and select Run as Administrator.

In the top menu of Notepad, select File > Open.
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5. Inthe Open dialog, select All Files (*.*) in the file type drop-down in the bottom-right corner.

6. Browse to and select the following file:

C:\Program Files (x86)\Toon Boom Animation\Toon Boom Harmony 17
[Edition] \etc\server.ini

In the file, there are numerous lines starting with FileSystem followed by a number, an equal sign,
and some of them will have information after the equal sign. This is the list of scene data storage
spaces used by your Harmony server. For example, a newly created database with a single storage
space will probably have this scene data storage space configuration:

[WizardConfig]
ServerName=SERVERNAME
InstallationDrive=C:\Program Files (x86)\Toon Boom Animation\Toon Boom Harmony
17 [Edition]

UsaShare=usa

UsadbDrive=C

UsadbShare=usa db

FileSystem0=C usadata000 SERVERNAME
FileSysteml

FileSystem2

FileSystem3

FileSystem4

[...]

NOTE

The server. inifile generated by Configuration Wizard contains a file system listing
going from 0 to 99. The sample file was shortened here to avoid cluttering the
documentation.

7. Inthefirst one of the FileSystem lines that has nothing after the equal sign, type in the
information for your scene data server, in the following format:

FileSysteml=<drive letter> <share name> <server name>
Replace the tags between <> brackets with the appropriate values. Make sure to remove the <>
brackets from the configuration file as well:

e <drive letter>:Thedriver letter of the drive on which the scene data storage space is
located, without any colon or backslash. For example, if the scene data storage space was
created on drive C:, simply type C.
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« <share name>: The name of the share containing the scene data. Usually, this share is
either named USADATA or usadata, and its name may be followed by a zero-padded, zero-
based number indicating the index of the scene data storage space. For example, the first
scene data storage space could be named USADATA or usadata000.

o <server name>: The host name of the scene data server. If the scene data storage space is
hosted on the same machine as the database, then this host name is the same as the host
name for the database.

For example, if the new scene data storage space is the second scene data storage space for the
server, and is located in C: \usadata001 of a computer with the hostname newserver, the
appropriate configuration for this would be as follows:

FileSysteml=C usadata000 newserver

In the top menu, select File > Save.

From now on, the next time you run the Configuration Wizard to set up a Harmony database client
on Windows, the new scene data storage space will be automatically added to the client
configuration. You can use the Configuration Wizard to re-configure existing clients, if needed.

How to connect the database server to a new remote scene data storage space

10.

Log in to the database server.

Open the Start menu and, in the Programs list, select Harmony 17 [Edition] > Tools > Control
Panel.

When prompted, allow Control Panel to make changes to your device.
In the Control Panel, open the Connections tab.

In the Sharename field, type in the network (UNC) path of the new scene data storage space. This
location should start with two backslashes followed by the hostname of the server on which this
storage space is hosted, followed by a backslash, then the name of the scene data storage space
itself, like in the following example:

\\newserver\usadata001l
In the Username field, type in the name of a user who has access to this network share.
In the Password field, type in this user's password.
Click on Create Connection.
Click on Close.

Right-click on the desktop, then select New > Shortcut.
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11.

12.

13.

14.

15.

16.

17.

18.

19.

The Create Shortcut dialog appears.

Under Type the location of the item:, type the network (UNC) path of the new scene data storage
space, asin step 5.

Click on Next.

Under Type a name for this shortcut:, type in the name of the share and nothing else. For example,
if the shortcut path is \\newserver\usadata001, the name of the shortcut should be
usadata001l.

Click on Finish.
Right-click on the shortcut and select Cut.
Open an Explorer window.

Browse to the root of the drive with the same drive letter as the one on which the new storage
space was added on the scene data server (ie:C:)

Right-click on the files list and select Paste.
When prompted, grant administrator permission to move the shortcut.

There is now a shortcut pointing to the new scene data storage space on the database server,
allowing it to connect to this storage space and create and manage scenes inside it.

How to add the new storage space to the list of storage spaces used by Harmony and
Control Center

Open the Start menu and, in the Programs list, select Toon BoomHarmony 17 [Edition) > Tools >
[fd Configuration Editor.

When prompted, allow Configuration Editor to make changes to your device.
Open the Manager.conf tab.

Scroll down to the bottom. There should be a line starting with scene_dir_pattern: followed by
the path to the scene data directories used by your server, except for the one you just created. For
example, if the server only had a scene data storage named usadata000, the line would be as
follows:

scene dir pattern /usadata000
After the last scene data storage space listed on the scene_dir patternline, add a space,

followed by a slash and the name of the new scene data storage space. For example, if you are
adding a scene data storage space named usadata001 and located at the root of your storage
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device, you should add it at the end of the line, like so:

scene dir pattern: /usadata000 /usadata001l

IMPORTANT
Even on Windows, the path to a scene data directory in Manager.conf must:
o Use forward slashes (/) as separators, not backward slashes (\).

« Start with a forward slash, not a drive letter. For example, instead of
C:\usadata001, type /usadata001.

o Not include the . 1nk extension of the shortcut file. If you are adding
C:\usadata001. 1nk, simply put /usadata001.

N TIP

You can also add * wildcards in the folder names. For example, this will include all scene
data directories at the root of your storage device with a name starting with usadata:

scene dir pattern: /usadata* /USADATA*
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Configuring a Windows Database Server to have a Static IP Address

It is common to configure server machines to have a static IP. This avoids having to rely on DNS resolution to
find the server when its IP address changes, and it also allows you to associate the hostname to the server's
static IP address on the machine to skip DNS resolution altogether, increasing network performance.

If your machine is currently connected to a DHCP server that dynamically assigns IP addresses, you can
configure your machine to permanently use its current IP address. To do this, you can start by making note of
the information for your current network connection, then using these parameters for a permanent IP address.

How to obtain the information about your current connection

1. Open Command Prompt and enter the following command:.
ipconfig /all

This will output information about your current connection:

Windows IP Configuration

<hostname>
<domain name>

Host Name .
Primary Dns Suffix

Node Type . . . . .
IP Routing Enabled.
WINS Proxy Enabled.
DNS Suffix Search List.

Ethernet adapter Ethernet:

Connection-specific DNS Suffix
Description

Physical Address.

DHCP Enabled. e
Autoconfiguration Enabled .
Link-local IPv6 Address
IPv4 Address.

Subnet Mask

Lease Obtained.

Lease Expires

Default Gateway .

DHCP Server

DHCPv6 IAID .

DHCPv6 Client DUID.

DNS Servers .

Primary WINS Server
NetBIOS over Tcpip.

Peer-Peer

: No
: No
: <domaine names>

<domain name>
<adapter name>
<MAC address>
Yes
Yes
<IPv6 address>

: <IPv4 address>
: <subnet mask>

<date of lease>
<date of expiration>

: <default gateway>

: <DNS server addresses>

65

<DHCP server address>
<DHCPv6 IAID>
<DHCPv6 Client DUID>

<WINS server address>
Enabled



Chapter 2: Harmony Server

2. Inthe output, under Ethernet adapter Ethernet, make note of the following data:

o Thedomainsin the DNS Suffix Search List
« ThelPv4 Address

o The Subnet Mask

o The Default Gateway address

e The addresses for the DNS Servers

How to configure a Windows server to use a static IP

1. Open the Windows Control Panel:

o On Windows 7: Open the Start menu and select All Programs > Accessories > System
Tools > Control Panel.

o On Windows 8.1 or Windows 10: Open the Start menu and, in the programs list, select
Windows System > Control Panel.

2. Click View network status and tasks.

3. On the top-left corner of the Network and Sharing Center, select Change adapter settings.

% Metwork and Sharing Center _ o X
« v a: » Control Panel » Network and Internet » Network and Sharing Center v trol P o

View your basic network information and set up connections
Contrel Panel Home I

View your active networks
Change adapter settings

Change advanced sharing de.toonboom.com Access type Internet
seftings Domain network Connections: § Ethemet

Change your networking settings
{64 St up 2 new connection or network

Set up 2 broadband, dial-up, or VPN connection; or set up a router or access point.

= Troubleshoot problems
=

Diagnose and repair network problems, or get troubleshooting information.
HomeGroup
Infrared

Internet Options

Windows Defender Firewall

4. Right-click on the network adapter used by your machine to connect to your local network, then
select Properties.
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The Local Area Connection Properties dialog appears.

% Ethernet Properties ®
Networking
Connect using
@ intel(F) Ethemet Connection (2) 1218-LM

This connection uses the following Rems:

) B Chart for Microsoft Networks -~
[ 58 Fle and Prrter Sharing for Microsoft Networks
B8 00s Pack chad

TS TR, STy TR
B s Mcrosoft LLDP Protocal Deiver

M 3 Intemet Protocol Version & (TCP/1PvE) v
< >

lnatall. eret Properties
Description

Transmission Control Protocel/intemet Protocol. The defauk
wide anea network protocol that provides communication
across diverse interconnected netwarks.

OK Cancel

5. Inthe items list, select Internet Protocol Version 4 (TCP/IPv4).
6. Click on the Properties button under the list.

The Internet Protocol Version 4 (TCP/IPv4) Properties dialog box opens.

rnet Protocol Version 4 (TCP/IPwd) Properties >
General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

Chtain an IP address automatically

e the following IP address:

¥ address: | | . . . |

Subnet mask: | . . . |

Default gateway: | . . . |

Cbtain DMS server address automatically

(®)

eferred DNS server: | . . . |

the following DNS server addresses:

Alternate DNS server: | . . . |

[Jvalidate settings upon exit Advanced...

Cancel

7. Select the Use the following IP address option.

8. Inthe IP Address field, enter the IPv4 Address you obtained in earlier.
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10.

11.

12.

13.

14.

15.

l16.

17.

18.
19.

20.

In the Subnet mask field, enter the Subnet mask you obtained earlier.

In the Default gateway field, enter the Default gateway address you obtained earlier.
Select the Use the following DNS server addresses option.

In the Preferred DNS server field, enter the DNS Servers address obtained earlier.

If a second DNS server was listed by ipconfig, type it in the Alternate DNS server field. Otherwise,
leave this field empty.

Click on Advanced.
The Advanced TCP/IP Settings dialog opens.

Select the DNS tab.

Advanced TCP/IP Settings b
IP Setfings  DNS WINS

DS srver addresses, in order of use:

10.120.0.6

Add... Edit... Remove

The follawing three settings are appled to all connections with TCPJTP
enabled. For resohution of unqualified names:

(0 Append primary and connection spedific DNS suffices

(®) Append these DNS suffives (n order):

DS suffi for this connection:

[IRegster this connection's addresses in DS
[Juse this connection's DNS suff in DNS registration

oK Cancel

Select the Append these DNS suffixes (in order): option.

For each DNS Suffix obtained earlier, click on Add, then type in the suffix. Add the suffixes in the
order in which there were listed.

Click on OK.
Click on OK in the Internet Protocol Version 4 (TCP/IPv4) Properties dialog.

Click on OK in the Ethernet Properties dialog.
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Looking Up the Database Server Log on Windows

In order to troubleshoot problems with the Harmony database server, you can look through its log. This is done
differently depending on whether you installed the database server as a Windows service using Configuration

Wizard or using Service Launcher.

How to check the log for the database server service

1. Open an Explorer window.

2. Browse to the following location:

C:\ProgramData\Toon Boom Animation\Toon Boom Harmony

3. Right-click on tbdbserver.log and select Open with > Notepad.

How to check the log for the database server in Service Launcher

1. Make sure you are currently signed in as the user running the service.
2. In the notification tray, click on the [§ Service Launcher icon.
The Service Launcher application opens.
3. Select the Database Server tab.
4. Inthe bottom half, select the Log tab.

5. Click on the View Complete Log button in the bottom-right corner.
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Launching the Database Server Manually on Windows

You can start the database server directly from a command line. This is usually not practical for a production
environment, but it can be very useful when troubleshooting problems. You can view the output of the server

directly in the command line as it launches and handles requests.

How to start the database server manually on Windows

1. Inacommand line, enter the following command:

C:\Program Files (x86)\Toon Boom Animation\Toon Boom Harmony 17
[Edition] \win64\bin\tbdbserver.exe
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How to Stop and Restart the Database Server on Windows

If you installed the database server as a Windows service using Configuration Wizard, you can stop it and
restart it using the Harmony Control Panel or the Windows Services control panel. If you installed it using
Service Launcher, you can stop it and restart it manually in Service Launcher.

How to stop and restart the database server service using the Harmony Control Panel

1. Open the Start menu and, in the Programs menu, select Harmony 17 [Edition) > Tools > m
Control Panel.

2. When prompted, allow Control Panel to make changes to your device.

3. Inthe Process Starter drop-down, select HarmonyStarterO-tbdbserver.

NOTE

The number after HarmonyStarter may be different, depending on how many Harmony
services were installed before this one.

4. Click on Stop.

5. When you are ready to start the server again, click on Start.

How to stop and restart the database server service using the Windows Services
control panel

1. Open the Windows Control Panel:

o On Windows 7: Open the Start menu and select All Programs > Accessories > System
Tools > Control Panel.

o On Windows 8.1 or Windows 10: Open the Start menu and, in the programs list, select
Windows System > Control Panel.

2. Inthe Control Panel, navigate to System and Security > Administrative Tools.

3. Double-click on Services.
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4. Scroll-down to HarmonyStarterO-tbdbserver.

NOTE

The number after HarmonyStarter may be different, depending on how many Harmony
services were installed before this one.

5. Right-click on the service and select Stop.

6. When you are ready to start the server again, right-click on it and select Start.

How to stop and restart the database server in Service Launcher

1. Make sure you are currently signed in as the user running the service.
2. In the notification tray, click on the [§ Service Launcher icon.
The Service Launcher application opens.
3. Select the Database Server tab.
4. Click on Stop.

5. When you are ready to start the server again, click on Launch.
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Pausing and Resuming the Database Server on Windows

If you need to perform maintenance or updates on a Harmony server, you can pause it instead of stopping it

completely.

Users who attempt to save a scene while the server is paused will receive a warning message. The server will
queue the save and commit the changes when the server is resumed.

How to pause the database server

1. In acommand prompt, enter the following command:

C:\Program Files (x86)\Toon Boom Animation\Toon Boom Harmony 17
[Edition] \win64\bin\dbu -p

How to check pause status of the database server

1. Inacommand prompt, enter the following command:

C:\Program Files (x86)\Toon Boom Animation\Toon Boom Harmony 17
[Edition] \win64\bin\dbu -P

How to resume the database server

1. In acommand prompt, enter the following command:

C:\Program Files (x86)\Toon Boom Animation\Toon Boom Harmony 17
[Edition] \win64\bin\dbu -res
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Uninstalling the Database Server on Windows

If you installed the database server as a Windows service using Configuration Wizard, you can uninstall it using
the Harmony Control Panel or the Windows Services control panel. If you installed it using Service Launcher,
you can uninstall it in Service Launcher.

How to uninstall the database server service using the Harmony Control Panel

1. Open the Start menu and, in the Programs menu, select Harmony 17 [Edition) > Tools > m
Control Panel.

2. When prompted, allow Control Panel to make changes to your device.

3. Inthe Process Starter drop-down, select HarmonyStarterO-tbdbserver.

NOTE

The number after HarmonyStarter may be different, depending on how many Harmony
services were installed before this one.

4. Click on Stop.
5. Click on Remove.
The database server service will stop and will no longer launch on boot.

6. Close the Control Panel.

How to uninstall the database server service using the Windows Services control panel

1. Open the Windows Control Panel:

o On Windows 7: Open the Start menu and select All Programs > Accessories > System
Tools > Control Panel.

o On Windows 8.1 or Windows 10: Open the Start menu and, in the programs list, select
Windows System > Control Panel.

2. Inthe Control Panel, navigate to System and Security > Administrative Tools.

3. Double-click on Services.
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4. Scroll-down to HarmonyStarterO-tbdbserver.

NOTE

The number after HarmonyStarter may be different, depending on how many Harmony
services were installed before this one.

5. Double-click on the service to open its Properties dialog.
6. Inthe Startup type drop-down, select Disabled.
7. Click on OK.

From that point on, the database server service will no longer launch on boot.

How to uninstall the database server in Service Launcher

1. Make sure you are currently signed in as the user running the service.
2. Inthe notification tray, click on the m Service Launcher icon.
The Service Launcher application opens.
3. Select the Database Server tab.
4. Click on Stop.
5. Uncheck the Launch when Service Launcher starts option.

6. In the top menu, select Server > Save All Settings.
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Database Server Installation on macOS

On macOS, you can create a database server by using the Configuration Assistant. The creation of the server is
done in two separate steps: The creation of the server's file structure, and the installation of the database

server daemon.
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Setting the Server Hostname on macOS

By default, unless your macOS server is configured to work with a domain name, macOS will append the suffix
.local toits chosen hostname. The configuration tools for Harmony will include this suffix when registering
the machine's hostname in its configuration.

This can cause a problem when working in a mixed platform environment, as only machines running on macOS
can communicate with your machine using the hostname with the . local suffix. Machines running Windows
or GNU/Linux will only be able to communicate with your macOS machine using its chosen hostname, without
the .local suffix.

To remedy this, you can manually override the machine's hostname and remove its suffix. This way, the
configuration tools for Harmony and the machines trying to communicate with your macOS machine will use
the hostname without a suffix.

NOTE

You should only follow this procedure if you do not intend to configure the machines in your
network to work with a domain name, as macOS will not append the suffix . local to the
hostname of computers connected through a domain.

How to manually override the hostname on macOS and remove its .local suffix

1. Inaterminal, obtain your current machine's hostname, as understood by macOS, with the following
command:

scutil --get HostName

2. Iftheresultis the hostname you chose for your machine followed by the suffix . local, override this
by typing the following command, where <hostname> is the hostname you chose for your machine,
without the suffix . local:

sudo scutil --set HostName <hostname>

3. Restart your machine.
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Creating a Harmony Database on macOS

The first step to creating a Harmony database server is to create the database's file structure on the machine
that will be used as the server.

How to create a Harmony database on macOS

1. In Finder, proceed to Applications > [Zll Toon Boom Harmony 17 [Edition] and double-click
Harmony [Edition].

The main Harmony application launches.
2. Inthe top menu, select Harmony [Edition] > Tools > Configuration Assistant.

3. Inthe Welcome screen, check the Create a new Toon Boom Harmony database and uncheck all
other options.

4. In the Create Harmony Database dialog, you can configure the options for your database server. It is
recommended to use the default options.

@ IMPORTANT

If the Hostname field displays a value that ends with .local, it is highly recommended to

remove this suffix before proceeding—see Setting the Server Hostname on macOS on

page 77.

5. If youwant the database server to also host scene data, leave the Create an empty Harmony File
System (/USADATA) option checked. If you want to only host scene data on other machines,
uncheck this option.

6. Click on Create.
7. When prompted, enter the username and the password of a user with administrator privileges.

The database's base file structure is now created. If you have opted to not create a scene data
storage space, see Creating a Scene Data Storage Server on macOS on page 95 to create a storage

space for the scenes on your Harmony database.
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Installing the Database Server Daemon on macOS

Once you have created a database file structure, you must also enable the database server daemon to allow
Harmony to connect to the database. This daemon runs through the user usabatch, so this user must be
created prior to installing the daemon.

NOTE

The following steps indicate how to make the database server daemon launch on boot, via the user
usabatch, who will have administrator privileges. If you prefer, you can make the database server
launch on log-in as the logged-in user. For more information, see Running the Database Server on

Log-In on macOS on page 81.

How to create the user usabatch on macOS

1. Open the Apple menu and select System Preferences.
2. Click on Users and Groups.

3. Inthe bottom-left corner of the Users & Groups dialog, click on the lock icon labeled Click the lock to
make changes to get administrator permissions.

4. Enter the username and password of an account with administrator privileges.
5. Click on the + button at the bottom of the user list.
The user creation panel appears.
6. Inthe New Account drop-down, select Administrator.
7. Inthe Full Name and Account Name fields, enter usabatch.
8. Give the user a password.

9. Click on Create User.

How to install the database server daemon on macOS

1. In Finder, proceed to Applications > [Zll Toon Boom Harmony 17 [Edition] and double-click
Harmony [Edition].

The main Harmony application launches.
2. Inthe top menu, select Harmony [Edition] > Tools > Configuration Assistant.
1. Inthe Welcome screen, check the Create the Startup Items option and uncheck all other options.

2. Click on Continue.
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Check the Create Database Server Startup Item option and uncheck all other options.
Click on Create.
When prompted, enter the username and the password of a user with administrator privileges.

The database server daemon is now installed and will start running. At this point, you should
already be able to run Control Center from this machine, log-in with the default user usabatch and
create scenes and users.
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Running the Database Server on Log-In on macOS

The traditional way of configuring the database server is by using the Configuration Assistant to install it as a
daemon. This makes the database server launch immediately on boot, as user usabatch.

Using Service Launcher, it is possible to configure your database server to only launch its database server
service as the logged-in user. This means the database will only be accessible if the user configured to run it is
signed in. Although this may seem impractical, it may be preferable for security reasons, mainly that the
logged-in user does not need to have administrator privileges to run services through Service Launcher.

If you have already installed the database server daemon using Configuration Assistant, you will need to
disable the daemon first to avoid launching two instances of the database server.

NOTE

While daemons run regardless of who is logged in and even when no user is logged-in, Service
Launcher will only run when the user for which it was specifically configured is logged in. This
means that if you want Service Launcher to launch when any user is logged in, you must configure it
for each user that has access to the machine.

How to disable the database server daemon

1. Inaterminal, type in the following command:

sudo launchctl unload -w
/Library/LaunchDaemons/com. toonboom.DatabaseServer.plist

The database server daemon will stop and will no longer launch on boot.

How to configure the database server to launch on user log-in

1. Make sure you are currently signed-in as the user who will run the service.
NOTE

This user will need to be logged in for the service to be running. The user does not need
to have administrator privileges.
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2. Doone of the following:

o IfService Launcher is not running, follow these steps to launch it:

a. In Finder, proceed to Applications > [Zll Toon Boom Harmony 17 [Edition) and
double-click Harmony [Edition).

The main Harmony application launches.

b. Inthetop menu, select Harmony [Edition] > Tools > Service Launcher.

« If Service Launcher is already running, click on its icon [§ in the menu bar.

The Service Launcher application window appears.

3. Inthe Application parameters section of the Preferences tab, make sure that the Launch on login
option is checked, so that services configured in Service Launcher automatically launch when you log
in to your account.

4. Select the Database Server tab.

5. Click on Launch to verify that the database server launches successfully through Service Launcher.
6. Check the Launch when Service Launcher starts option.

7. Inthe top menu, select Server > Save All Settings.

From now on, the database server will launch through Service Launcher when you log in.
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Sharing the Harmony Database Files Using NFS on macOS

Once you have a database file structure and the Harmony database server daemon, you can access the
database from the machine on which it was created. To allow other client machines on your network to access
the database, you must share its folders using NFS.

NOTE

This procedure will only allow macOS and GNU/Linux based clients to access the database. If you
want Windows clients to be able to connect to your Harmony server, see About Supporting

Windows Clients for macOS Servers on page 85.

How to share the database files using the NFS protocol for macOS or GNU/Linux
clients

1. In aterminal, enter the following command:
sudo vi /etc/exports

2. Add the following line to allow clients to access the database files:
/USA_DB -maproot=nobody

3. If your database server also has a scene data storage space, add a line with a similar syntax to share
it. For example, if the scene data storage space is named /USADATA, add the following line:

/USADATA -maproot=nobody
4. Save and exit.
5. Verify that the NFS exports are properly configured with the following command:
sudo nfsd checkexports
The command will not return anything if the exports file is properly configured.
6. Make sure the NFS sharing service is enabled with the following command:
sudo nfsd enable
7. Ifthe service was already started, terminate it to force it to load your configuration changes.

sudo kill -1 ‘cat /var/run/mountd.pid’
NOTE

The back quote () character is located at the top-left of the macOS keyboard on the
same key as the tilde (~) character. Or simply reboot the computer.
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8. Verify that the folders are shared:

showmount -e

The command should output a line for each directory you are sharing using the NFS protocol. For
example:

/USA_DB Everyone
/USADATA Everyone

You should now be able to mount the shared folders from any macOS or GNU/Linux-based machine
on your local network.
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About Supporting Windows Clients for macOS Servers

A macOS server can natively handle requests from macOS and GNU/Linux clients. However, in order to allow
Windows based clients to connect to the server, extra steps must be followed:

e The Link Server daemon must be installed. This allows Windows clients to create symbolic links on your
macOS server.

« Your database files must be shared via the Samba protocol, which is used by Windows clients to access
the database.

o The server.ini file must be filled with information on your database server and its scene data storage
spaces. This allows Configuration Wizard to configure Windows clients automatically.

Installing the Link Server Daemon on macOS L 86
Running the Link Server on Log-1n on macOS . 87
Sharing the Harmony Database Files Using SambaonmacOS ... ... ... ... . ... 89
Configuring a macOS Database Server for Windows Clients ... ... ... ... ... 93
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Installing the Link Server Daemon on macOS

If you installed the database server daemon using Configuration Assistant and want your macOS based server
to support Windows clients, you must also install the link server daemon.

How to install the database server daemon on macOS

1. In Finder, proceed to Applications > [Zll Toon Boom Harmony 17 [Edition] and double-click
Harmony [Edition].

The main Harmony application launches.
2. Inthe top menu, select Harmony [Edition] > Tools > Configuration Assistant.
3. Inthe Welcome screen, check the Create the Startup Items option and uncheck all other options.
4. Click on Continue.
5. Check the Create Link Server Startup Item option and uncheck all other options.
6. Click on Create.
7. When prompted, enter the username and the password of a user with administrator privileges.

The link server daemon is now installed and should start immediately.
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Running the Link Server on Log-In on macOS

If you configured your database server to launch using Service Launcher, you will also want the Link Server to
launch using service launcher, so that it launches in the same circumstances and environment. For more
information on running the database server with Service Launcher, see Running the Database Server on Log-

In on macOS on page 81.

If you have already installed the link server daemon using Configuration Assistant, you will need to disable the
daemon first to avoid launching two instances of the linkserver.

NOTE

While daemons run regardless of who is logged in and even when no user is logged-in, Service
Launcher will only run when the user for which it was specifically configured is logged in. This
means that if you want Service Launcher to launch when any user is logged in, you must configure it
for each user that has access to the machine.

How to disable the link server daemon

1. Inaterminal, type in the following command:

sudo launchctl unload -w
/Library/LaunchDaemons/com. toonboom.LinkServer.plist

How to configure the link server to launch on user log-in

1. Make sure you are currently signed-in as the user who will launch the link server.

NOTE

This user will need to be logged in for the link server to be running. The user does not
need to have administrator privileges.

2. Do one of the following:

o If Service Launcher is not running, follow these steps to launch it:

a. In Finder, proceed to Applications > izl Toon Boom Harmony 17 [Edition] and
double-click Harmony [Edition).
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The main Harmony application launches.

b. Inthe top menu, select Harmony [Edition] > Tools > Service Launcher.

« If Service Launcher is already running, click on its icon [§ in the menu bar.

The Service Launcher application window appears.

In the Application parameters section of the Preferences tab, make sure that the Launch on login
option is checked, so that services configured in Service Launcher automatically launch when you log
in to your account.

Select the Link tab.

Click on Launch to verify that the Link Server launches successfully through Service Launcher.
Check the Launch when Service Launcher starts option.

In the top menu, select Server > Save All Settings.

From now on, the link server will launch through Service Launcher when you log in.
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Sharing the Harmony Database Files Using Samba on macOS

Installing Samba for a macOS server is only required if you have Windows based client workstations on your
network, as they cannot connect to the database server using NFS. Because Samba is no longer supported by
macOS, it must be installed as a third party software on your machine.

Configuring a Harmony database server to share via Samba requires the following steps:

« Disabling the SMB file sharing protocol natively supported by macOS. This protocol may interfere with
Samba. Since its options are limited and optimized for personal use, it cannot be used for a Harmony
server.

o Installing SMBup, a third-party implementaton of Samba for macOS.
« Configuring the shared folders.

« Creating a Sharing type user account. This is required because this implementation of Samba fails to
authenticate users that are part of 15 groups or more, and macOS subscribes all users to more than 15
system groups in the back-end, except for Sharing type users.

IMPORTANT

Since this procedure requires installing and configuring a third party software, consider these
instructions as indicative only. Using Samba to connect to a macOS based Harmony server cannot
be guaranteed to succeed and, even if it succeeds, nothing guarantees it will still work after
updating macOS.

How to disable the native SMB file sharing protocol on macOS

1. Open the Apple menu and select System Preferences.
2. Click on Sharing.

3. Inthelist tothe left, if File Sharing is unchecked, then SMB is implicitly disabled. If File Sharing is
checked, select it.

4. Click on Options.
5. Make sure that Share files and folders using SMB is unchecked.
6. Click on Done.

7. Close the Sharing panel.
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How to share the database files using the Samba protocol for Windows clients

1.

10.

11.

12.

13.

14.

15.

16.

17.

Download the SMBUp package from the following website:

http://eduo.info/apps/smbup

In Finder, open your Downloads directory, then drag and drop the SMBup package into the
Applications directory.

Navigate to the Applications directory.
Right-click on SMBup and select Open.

You will be prompted to confirm that you want to launch the application, as it is from an unidentified
developer.

Click on Open.

After the donation prompt, a message will appear stating that Samba is not installed.
Click on Install Samba for me.

In the next prompt, read the advisory.

Click on Ok, help me install the software.

Click on Download and install package.

At the prompt, type in the username and password of an account with administrator privileges to
allow SMBup to install Samba.

Once the installation is done, click on Configure Shared Disks.
Near the top-left corner, click on the Lock icon to obtain administrative privileges.
Enter the username and password of an account with administrator privileges.

In the Name field, make sure the name of your Samba server matches the name of your server
machine.

Click on Save All.

Close SMBup. We will configure Samba using the terminal, to make sure it is precisely configured
with the right options.

In the confirmation prompt, click on Start Samba for me and Quit Application.

The Samba service is now installed and enabled.
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Configuring Samba shares on macOS

1. In aterminal, open the Samba configuration file to configure Samba and add your database
directories as Samba shares:

vi /opt/local/etc/samba3/smb.conf

2. Underthe [global] section of smb.conf, add the following options:

[global]

encrypt passwords yes
blocking locks no
oplocks no

level2 oplocks no
follow symlinks yes
unix extensions no
wide links yes

3. Atthe bottom of the Samba configuration file, add the following:

[USA DB]
comment Harmony Database
browseable yes

read only no

guest ok no

create mask 07717

directory mask 0777

path /USA DB

[usa]

comment Harmony Binaries and Configuration
browseable yes

read only no

guest ok no

create mask 07717

directory mask 0777

path /Rpplications/Toon Boom Harmony 17 [Edition]/Harmony
[Edition] .app/Contents/tba
[USADATA]

comment Harmony Scene Data 000
browseable yes

read only no

guest ok no

create mask 0777

directory mask 0777

path /USADATA

4. Verify that Samba understands the parameters in its configuration file with the following command:

/opt/local/bin/testparm

91



Chapter 2: Harmony Server

How to create a user account for Samba on macOS

10.

Open the Apple menu and select System Preferences.
Click on Users and Groups.

In the bottom-left corner of the Users & Groups dialog, click on the lock icon labeled Click the lock to
make changes to get administrator permissions.

Enter the username and password of an account with administrator privileges.
Click on the + button at the bottom of the user list.

The user creation panel appears.

In the New Account drop-down, select Sharing Only.

In the Full Name and Account Name fields, enter the desired name for the user who will have
access to the Samba share.

Give the user a password.
Click on Create User.

A local user must be added to the list of users with access to the Samba shares. To do this, type in
the following command:

sudo smbpasswd -a usabatch

You will be prompted to assign a password to the user, then to confirm it. This username and
password will be used to connect to the Samba shares.

NOTES

o The user you are adding to the list of Samba users must already exist as a regular
user on the machine.

o« On Windows clients, when using the Configuration Wizard to configure Harmony
database clients, you must enter this user's username and password in order to be
able to connect to the database shares.
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Configuring a macOS Database Server for Windows Clients

In order to allow Windows clients to connect to your server using the Configuration Wizard, you must fill in the
server.ini configuration file, which is located in the etc subfolder of the Harmony installation package. This file
will provide Configuration Wizard with information on the server as well as of each scene data server it is

connected to.

How to configure the server.ini file on macOS

1. Inaterminal, type in the following command:

sudo vi "/Applications/Toon Boom Harmony 17 [Edition]/Harmony
[Edition] .app/Contents/tba/etc/server.ini"

2. In server.ini, typein the information for the database server as well as the directory name and
hostname of every scene data server in your network, like in the following example:

[WizardConfig]
ServerName=<server name>
InstallationDrive=C
UsaShare=<harmony share name>
UsadbDrive=C
UsadbShare=<database share name>

Replace the tags between <> brackets with the appropriate values. Make sure to remove the <>
brackets from the configuration file as well:

e <server name>: The host name of the Harmony database server.

o <harmony share name>: The name of the share that gives access to the Harmony binaries
and configuration files. By default, this share is named usa.

o <database share name>: The name of the share that gives access to the database files.
By default, this share is named USA_DB.

For example, if your database server is called harmonyserver, your Harmony installation is shared
under the share name usa and your Harmony database is shared under the share name USA_DB,

this would be the proper configuration for this server:

[WizardConfig]
ServerName=harmonyserver
InstallationDrive=C
UsaShare=usa
UsadbDrive=C
UsadbShare=USA DB
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3. Under the line starting with UsadbShare, enter information about each scene data storage space
used by your Harmony database, in the following format:

FileSystem<file system number>=C <share name> <server name>

Replace the tags between <> brackets with the appropriate values. Make sure to remove the <>
brackets from the configuration file as well:

e <file system number>: The zero-based index of the scene data storage space. For
example, the first scene data storage space for your database should be named
FileSystemO and the second one, FileSysteml.

o <share name>: The name of the share containing the scene data. Usually, this share is
either named USADATA or usadata, and its name may be followed by a zero-padded, zero-
based number indicating the index of the scene data storage space. For example, the first
scene data storage space could be named USADATA, usadata000, usadata001, etc.

o <server name>: The host name of the scene data server. If the scene data storage space is
hosted on the same machine as the database, then this host name is the same as the host
name for the database. Otherwise, you must specify the name of the machine on which the
scene data storage space is located.

For example, if this is the first scene data storage space for your database, it is hosted on a computer
named dataserver and its name is usadata000, the appropriate configuration for this would be
as follows:

FileSystem0=C usadata000 dataserver

@ IMPORTANT

The variable names and share names in server.ini are case sensitive.

NOTE

server.ini also specifies the drive letter on which the software, the database files and scene
data files are stored. Since we are configuring a UNIX-based server, there is no actual drive
letter involved. Hence, we are using the drive letter C as a placeholder so as to respect the
expected format of the server. ini configuration file, but the value of these parametersis not
relevant and will not affect your configuration.
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Creating a Scene Data Storage Server on macOS

You can create additional scene data storage spaces for your Harmony database on machines. The database
server will connect to these machines to transmit scene data to the clients, allowing you to expand the storage
capacity of your database.

Creating a scene data storage space for your Harmony database requires following these steps:

1. Creating a folder named usadata followed by the index number of the storage space at the root of the
machine.

2. Sharing the folder via NFS and, if Windows clients must be supported, via Samba as well.
3. Mounting this folder on the database server.

4. If Windows clients must be supported, adding this storage server to the server.ini configuration file.

How to create a scene data storage space on macOS

1. In aterminal, enter the following command, where ### is the padded, zero-based index of the
storage space you are creating, replace ### with 001:

sudo mkdir -m 777 /usadata###

A folder in which scene data will be stored is created at the root of the filesystem.

How to share the scene data storage space on macOS

1. Sharing a scene data storage space is done the exact same way as sharing the server's database file
system.

« Toshare the scene data storage space for macOS and GNU/Linux based clients, see Sharing
the Harmony Database Files Using NFS on macOS on page 83.

« Toshare the scene data storage space for Windows clients, see Sharing the Harmony
Database Files Using Samba on macOS on page 89.

Once thisis done, you should already be able to mount the new scene data storage space on the
database server as well as on clients.

How to mount the new scene data storage space on a macOS database server

1. First, you should set a permissive file permission mask on the server machine. This will make it so
files created by the database server on the scene data server will have the proper permissions to
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allow any user to edit them. To do this, see Setting the User File Creation Permission Mask on

macOS on page 169.

2. In aterminal, create a folder at the root of the filesystem in which the new scene data storage space
will be mounted with the following command, where <foldername> is the name of the scene data
directory you created on the scene data server:

sudo mkdir -m 777 /<foldername>
3. open the filesystem table in a text editor by typing the following command:
sudo vi /etc/fstab

4. In the filesystem table, add the following line, replacing <servername> with the name of the scene
data server and <foldername> with the name of the scene data directory you created on this
scene data server:

<servername>: /<foldername> /mnt/<foldername> nfs rw, soft,intr, resvport 0 0

5. Save and quit.
6. Attempt to mount the entries of the filesystem table:
sudo mount -a

7. To make sure that it worked, try creating a file in the new scene data storage, and verify that it's
visible from both machines. To do this:

o On one machine, enter the following command:
touch /<foldername>/testfile
e On the other machine, enter the following command to verify that test£file is present

ls /<foldername>/

How to add the scene data storage file to the server.ini configuration file

1. Inaterminal, type in the following command:

sudo vi "/Applications/Toon Boom Harmony 17 [Edition]/Harmony
[Edition] .app/Contents/tba/etc/server.ini"

If the file was already configured, it most likely contains configuration in the following format:

[WizardConfig]

ServerName=<name of Harmony server>
InstallationDrive=C

UsaShare=usa

UsadbDrive=C
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UsadbShare=USA DB
FileSystem0=C usadatal00 <name of first scene data server>

2. Under the last line starting with FileSystemO which contains information about an existing scene

data storage space, enter the information about your new scene data storage space in the following
format:

FileSystem<file system number>-C <share name> <server name>

Replace the tags between <> brackets with the appropriate values. Make sure to remove the <>
brackets from the configuration file as well:

o« <file system number>: The zero-based index of the scene data storage space. For
example, the first scene data storage space for your database should be named
FileSystemO and the second one, FileSysteml.

o« <share name>: The name of the share containing the scene data. Usually, this share is
either named USADATA or usadata, and its name may be followed by a zero-padded, zero-
based number indicating the index of the scene data storage space. For example, the first
scene data storage space could be named USADATA, usadata000, usadata001, etc.

o <server name>: The host name of the scene data server. If the scene data storage spaceis
hosted on the same machine as the database, then this host name is the same as the host
name for the database. Otherwise, you must specify the name of the machine on which the
scene data storage space is located.

For example, if this is your second scene data storage space for your database server, it is hosted on
a computer named newdataserver and is named usadata001, its configuration would be as
follows:

FileSysteml=C usadata00l newdataserver

IMPORTANT

The variable names and share names in server. ini are case sensitive.
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NOTE

The first information for a scene data storage space, C, is actually the drive letter on which the
scene data storage space is located. Since macOS does not use drive letters, there is no drive
letter for this storage space, and we are only specifying a drive letter to respect the format of
the server. ini configuration file. This value does not have an effect your server

configuration.
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Configuring a macOS Database Server to have a Static IP Address

It is common to configure server machines to have a static IP. This avoids having to rely on DNS resolution to
find the server when its IP address changes, and it also allows you to associate the hostname to the server's
static IP address on the machine to skip DNS resolution altogether, increasing network performance.

If your machine is currently connected to a DHCP server that dynamically assigns IP addresses, you can
configure your machine to permanently use its current IP address. To do this, you can start by making note of
the information for your current network connection, then using these parameters for a permanent IP address.

How to obtain information about your current connection on macOS
1. Open the Apple menu and select System Preferences.

2. Click on Network.

The Network configuration panel appears.

L] Network
Location:  Automatic ﬁ
Ethernat
e Status: Connected
- Etharnet is current iy active and has the IP
Wi-Fi — address 10.120.3.27.
o Bluetooth PAN a Configure IPvd:  Using DHCF B

@ Firewire IP Address: 10.120.3.27

Subnet Mask: 255.2565.240.0

® Thunde...t Bridge
. Router: 10.120.0.254

DNS Server:

Search Domains:

Advanced...

+— |~

Assist Me...

3. Inthelist to the left, select Ethernet.
4. Inthe panel to the right, make note of the following information:
o ThelP Address
e The Subnet Mask
o The Router address
o The DNS Server

e The Search Domains
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How to configure a macOS server to use a static IP

=

Open the Apple menu and select System Preferences.
2. Click on Network.
3. Inthelist tothe left, select Ethernet.

4. In the Location drop-down, select Edit Locations.

800 Network
| > Show All (Q

Location ¥ Automatic |

[ —

e é_’"? Status: Connected
. X Ethernet is currently active and has the IP

@ FireWire address 10.120.3.80.

Mot Connected
@ Wi-Fi = Configure IPv4: | Using DHCP i

pive = onfigure : | Using :
@ Bluetooth PAN 9 IP Address: 10.120.3.80

Mot Connected

Subnet Mask: 255.255.240.0
Router: 10.120.0.254
DNS Server: 10.120.0.1

Search Domains: toonboom.com

+[ [~ [ Advanced... | (7)

l
[£ Click the lock to prevent further changes. | Assistme... | | Rewvert | | Apply |

5. Click on the + button to add a location, then name it Static.

' Locations
Automatic
Static

| Done |

6. Click on Done.
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10.

11.

12.

Click on Advanced.

In the TCP/IP tab of the Advanced Network panel, enter the following information:
o Setthe IPv4 Address to the IP Address obtained earlier.
« Set the Subnet Mask to the Subnet Mask obtained earlier.
« Set the Router address to the Router address obtained earlier.

Open the DNS tab.

Under the DNS Servers list, click on the + button to add a DNS server. Add each of the DNS Server
addresses obtained earlier.

Under the Search Domains list, click on the + button to add a search domain. Add each of the
search domains obtained earlier.

Click on OK.

If your configuration works, the Network panel will indicate Status: Connected at the top.

S'1C|'J"' A |
Location: | Static =
8 @“"> Status: Connected
X X Ethernet is currently active and has the IP

@ FireWire address 10.120.3.8.
@ Wi-Fi ‘-'-:';'3-” Configure IPv4: | Manually =

IP Address: | 10.120.3.8

Subnet Mask: | 255.255.240.0
Router: | 10.120.0.254
DNS Server:
Search Domains:
i | Advanced... | '.-'
'J_ | Click the lock to prevent further changes. Assist me... Revert Apply

101



Chapter 2: Harmony Server

Looking Up the Database Server Log on macOS

In order to troubleshoot problems with the Harmony database server, you can look through its log. This is done
differently depending on whether you installed the database server as a daemon using Configuration

Assistant, or using Service Launcher.

If your server is configured for Windows clients, you can also check the link server log for issues.

How to check the log for the database server daemon

1. In aterminal, enter the following command:

less /tmp/com.toonboom.DatabaseServer.log

How to check the log for the link server daemon

1. Inaterminal, enter the following command:

less /tmp/com.toonboom.LinkServer.log

How to check the log for the database server in Service Launcher

1. Make sure you are currently signed in as the user running the service.
2. Inthetop menu, click on the Service Launcher m icon.
The Service Launcher application opens.
3. Select the Database Server tab.
4. In the bottom half, select the Log tab.

5. Click on the View Complete Log button in the bottom-right corner.

How to check the log for the link server in Service Launcher

1. Make sure you are currently signed in as the user running the service.
2. In the top menu, click on the Service Launcher [ icon.

The Service Launcher application opens.
3. Select the Link tab.

4. In the bottom half, select the Log tab.
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5. Click on the View Complete Log button in the bottom-right corner.
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Launching the Database Server Manually in macOS
You can start the database server directly from a terminal. This is usually not practical for a production
environment, but it can be very useful when troubleshooting problems.

If your server needs to handle Windows clients, you can also launch the link server in a different terminal to

ensure that both services work.

You can view the output of both services directly in the terminal in which you launch them as they start and

handle requests.

How to start the database server manually

1. Inaterminal, enter the following command:

"/Applications/Toon Boom Harmony 17 [Edition]/Harmony
[Edition] .app/Contents/tba/macosx/bin/tbdbserver"

How to start the link server manually

1. In another terminal, enter the following command:

"/Applications/Toon Boom Harmony 17 [Edition]/Harmony
[Edition] .app/Contents/tba/macosx/bin/Link_srv"
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Stopping and Restarting the Database Server on macOS

If you installed the database server as a daemon using the Configuration Assistant, you can stop it and restart it
using the 1launchetl command line tool. If you installed it using Service Launcher, you can stop it and restart it
manually in Service Launcher.

If you have installed the link server so as to be able to handle Windows clients, stopping and restarting it may

also be necessary for the intended purpose.

How to stop and restart the database server daemon

1. In aterminal, enter the following command:

sudo launchctl unload
/Library/LaunchDaemons/com. toonboom.DatabaseServer.plist

2. When you are ready to start the server again, enter the following command:

sudo launchctl load
/Library/LaunchDaemons/com. toonboom.DatabaseServer.plist

How to stop and restart the link server daemon

1. Inaterminal, enter the following command:

sudo launchctl unload
/Library/LaunchDaemons/com. toonboom.LinkServer.plist

2. When you are ready to start the server again, enter the following command:

sudo launchctl load
/Library/LaunchDaemons/com. toonboom.LinkServer.plist

How to stop and restart the database server in Service Launcher

1. Make sure you are currently signed in as the user running the service.
2. Inthe top menu, click on the Service Launcher m icon.
The Service Launcher application opens.
3. Select the Database Server tab.
4. Click on Stop.

5. When you are ready to start the server again, click on Launch.
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How to stop and restart the link server in Service Launcher

1. Make sure you are currently signed in as the user running the service.
2. Inthe top menu, click on the Service Launcher g icon.
The Service Launcher application opens.
3. Select the Link Server tab.
4. Click on Stop.

5. When you are ready to start the server again, click on Launch.
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Pausing and Resuming the Database Server on macOS

If you need to perform maintenance or updates on a Harmony server, you can pause it instead of stopping it
completely.

Users who attempt to save a scene while the server is paused will receive a warning message. The server will
queue the save and commit the changes when the server is resumed.

How to pause the database server

1. In acommand prompt, enter the following command:

"/Applications/Toon Boom Harmony 17 [Edition]/Harmony
[Edition] .app/Contents/tba/macosx/bin/dbu" -p

How to check pause status of the database server

1. Inacommand prompt, enter the following command:

"/Applications/Toon Boom Harmony 17 [Edition]/Harmony
[Edition] .app/Contents/tba/macosx/bin/dbu" -P

How to resume the database server

1. In acommand prompt, enter the following command:

"/Applications/Toon Boom Harmony 17 [Edition]/Harmony
[Edition] .app/Contents/tba/macosx/bin/dbu" -res
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Uninstalling the Database Server on macOS

If you installed the database server as a daemon using the Configuraton Assistant, you can uninstall it using the
launchectl command line tool. If you installed it using Service Launcher, you can uninstall it in Service
Launcher.

How to uninstall the database server daemon

1. Inaterminal, enter the following command:

sudo launchctl unload -w
/Library/LaunchDaemons/com. toonboom.DatabaseServer.plist

The daemon will no longer launch on boot.

2. Ifyouwant, you can delete the daemon permanently with the following command:

sudo rm /Library/LaunchDaemons/com.toonboom.DatabaseServer.plist

How to uninstall the link server daemon

1. In aterminal, enter the following command:

sudo launchctl unload -w
/Library/LaunchDaemons/com. toonboom.LinkServer.plist

The daemon will no longer launch on boot.

2. Ifyouwant, you can delete the daemon permanently with the following command:

sudo rm /Library/LaunchDaemons/com.toonboom.LinkServer.plist

How to uninstall the database server in Service Launcher

1. Make sure you are currently signed in as the user running the service.
2. Inthe top menu, click on the Service Launcher m icon.
The Service Launcher application opens.
3. Select the Database Server tab.
4. Click on Stop.
5. Uncheck the Launch when Service Launcher starts option.

6. Inthe top menu, select Server > Save All Settings.
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How to uninstall the link server in Service Launcher

1. Make sure you are currently signed in as the user running the service.
2. Inthe top menu, click on the Service Launcher g icon.
The Service Launcher application opens.
3. Select the Link Server tab.
4. Click on Stop.
5. Uncheck the Launch when Service Launcher starts option.

6. Inthetop menu, select Server > Save All Settings.
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Database Server Installation on GNU/Linux

On GNUJ/Linux, you can create a database server with the help of a script that creates the basic database file
structure, then enabling the database server daemon which was created during the installation of Harmony.
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Disabling Security for a Harmony Database Server on GNU/Linux

GNU/Linux comes bundled with two core security components:

« A firewall (typically either iptables or firewalld), which will block incoming connections that were not
specifically allowed.

o SELinux, a kernel security module that enforces access control policies on software, files and network
resources.

The default configuration for these components will prevent clients from connecting to a Harmony database
server. This installation guide provides instructions on how to add security exceptions to these components so
that they do not have to be disabled. However, you may prefer to disable them so as to simplify the installation
process or to rule out security components as possible causes when troubleshooting an issue.

IMPORTANT

If you choose to disable the firewall and SELinux, it is critical to ensure that your domain has
effective site-wide security measures to prevent unauthorized access to your database server.

How to disable the firewall on CentOS 6, RedHat Entreprise Linux 6 or other systems
using the iptables service

1. In aterminal, enter the following commands:

sudo chkconfig iptables off
sudo service iptables stop

How to disable the firewall on CentOS 7, RedHat Entreprise Linux 7 or other systems
using the firewalld service

1. In aterminal, enter the following commands:

sudo systemctl disable firewalld
sudo systemctl stop firewalld

How to disable SELinux

1. Inaterminal, enter the following command:
sudo vi /etc/selinux/config

2. Find the line with the following parameter:
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SELINUX=enforcing

3. Replace enforcing with disabled:

SELINUX=disabled

IMPORTANT

Double-check to make sure you did not make any typo. An error in the SELinux
configuration file may cause GNU/Linux to fail to boot.

4. Save and quit.

5. Reboot to apply the new configuration.
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Creating a Harmony Database on GNU/Linux

The first step to creating a Harmony database server is to create the database's file structure on the machine
that will be used as the server. You can accomplish this by running the create_usa_db script from Harmony's

bin directory.

The basic database file structure is in the USA_DB directory. However, this is not where scene data is stored. If
you want the database server to be able to host scene data, you can also create an empty scene data storage

space alongside your database file structure.

NOTE

The following steps only indicate how to create a database file structure using the create_usa__
db script. If you prefer, you can create the database file structure and enable the database server
daemon simultaneously using the Harmony installation script—see Installing the Database Server

Daemon on GNU/Linux on page 114.

How to create a database file structure using the create_usa_db script

1. In aterminal, navigate to the directory in which the Harmony binaries were installed:

cd /usr/local/ToonBoomAnimation/harmony[Edition]_ 17/1nx86_ 64/bin
2. Run the database creation script:

sudo ./create_usa_db

The script will create the basic file structure for a Harmony database in /USA_DB.

How to create a scene data storage space

1. Inaterminal, enter the following command:
sudo mkdir -m 777 /usadata000

A scene data storage directory named usadata000 is now located at the root of your database

server's file system.
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Installing the Database Server Daemon on GNU/Linux

Once you have created a database file structure, you must also enable the database server daemon to allow
Harmony to connect to the database. This daemon runs through the user usabatch, so this user must be

created prior to installing the daemon.

The Harmony installer for GNU/Linux always installs daemon scripts on your machine, but does not enable
them by default. Hence, there are two approaches to installing the database server daemon:

« By enabling the daemon that was already installed with Harmony using the chkconfig command.

o Byrunning the Harmony installation script with the -d parameter. This will also create a database file

structure on your machine if none is present.

This daemon runs through the user usabatch, so this user must be created prior to installing the daemon.

NOTE

The following steps indicate how to make the database server daemon launch on boot, via the user
usabatch. If you prefer, you can make the database server launch on log-in as the logged-in user.
For more information, see Running the Database Server on Log-In on GNU/Linux on page 116.

How to create the usabatch user on GNU/Linux

1. Inaterminal, enter the following command:

sudo useradd -m usabatch
sudo passwd usabatch

2. When prompted, enter the password you want to assign to the user usabatch, then confirm it.

The user usabatch is now created and can be used to run Harmony daemons.

How to enable the database server daemon on GNU/Linux

1. In aterminal, enter the following command to enable the database server daemon:
sudo chkconfig toonboom dbserver on

If the command returns nothing, it succeeded. The database server will launch next time you boot

the machine.
2. Tolaunch the database server daemon immediately, run the following command:
sudo service toonboom dbserver start

The command will report whether it succeeded or failed.
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How to create a database file structure and enable the database server daemon
simultaneously using the Harmony installation script

1. Inaterminal, navigate to the directory where you downloaded the installation package.
cd ~/Downloads
2. Extract the package's contents in the directory.
tar -xvzf ./name-of-package.tar.gz
3. Switch to the directory in which the package's contents were extracted.
cd name-of-package
4. Run the installer with the -d parameter:
sudo ./install -d
5. When prompted, confirm that you want to proceed with the installation.

The installation script will create a database file structure in /USA_DB, enable the database server
daemon and start it.

NOTE

The installation script will not create a database file structure in /USA_DB if this directory
already exists, whether it is a local database or a remote database mounted on the file system.

115



Chapter 2: Harmony Server

Running the Database Server on Log-In on GNU/Linux
The traditional way of running the Harmony database server is by installing it as a daemon. This makes the
database server launch immediately on boot, as user usabatch.

Using Service Launcher, it is possible to configure your database server to only launch its database server
service as the logged-in user. This means the database will only be accessible if the user configured to run it is
signed in. Although this may seem impractical, it may be preferable for security reasons, mainly that the
logged-in user does not need to have administrator privileges to run services through Service Launcher.

If you have enabled the database server daemon, you will need to disable and stop it before you can configure it
to launch with Service Launcher, to avoid launching two instances of the database server.

NOTE

While daemons run regardless of who is logged in and even when no user is logged-in, Service
Launcher will only run when the user for which it was specifically configured is logged in. This
means that if you want Service Launcher to launch when any user is logged in, you must configure it
for each user that has access to the machine.

How to disable the database server daemon

1. Inaterminal, type in the following commands to stop, then disable the daemon:

sudo service toonboom dbserver stop
sudo chkconfig toonboom dbserver off

The database server daemon will stop and will no longer launch on boot.

How to configure the database server to launch on user log-in

1. Make sure you are currently signed-in as the user who will run the service.

NOTE

This user will need to be logged in for the service to be running. The user does not need
to have administrator privileges.

2. Do one of the following:

« If Service Launcher is not running, in the GNOME top menu, select Applications > Harmony
17 (Edition) > FJ§ Service Launcher.
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o If Service Launcher is already running, click on its icon m in the system tray.
The Service Launcher application starts.
3. Select the Database Server tab.
4. Click on Launch to verify that the database server launches successfully through Service Launcher.
5. Check the Launch when Service Launcher starts option.
6. Inthe top menu, select Server > Save All Settings.

From now on, the database server will launch through Service Launcher when you log in.
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Expanding the File Descriptor Limit for a Database Server on
GNU/Linux

If your database server is likely to have a lot of connected clients, you should expand the file descriptor limit for
the user who will run the database server daemon.

How to expand the file descriptor limit for the database server

1. In aterminal, open the limits configuration file in a text editor:
sudo vi /etc/security/limits.conf

2. Attheend of thefile, just before the # End of file line, add the following lines, replacing
<username> with the name of the user who runs the database server daemon:

<username> soft nofile 16384
<username> soft nofile 16384

For example, if you installed the database server as a daemon, it will run as user usabatch by default.
Hence you would need to add the following lines before # End of file:

usabatch soft nofile 16384
usabatch soft nofile 16384

3. Save and quit.
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Opening the Firewall Ports for a Harmony Database Server on
GNU/Linux

The GNU/Linux firewall will block attempts from other computers to communicate with the database server. In
order to circumvent this, the ports used by the database server must be opened.

How to allow connections to the database server to go through the firewall on CentOS
6, RedHat Entreprise Linux 6 or other systems using the iptables service

1. Addthe ports used by the database server to the list of open ports with the following commands:

sudo iptables -I INPUT -m state --state NEW -p tcp -m tcp --dport
5678 -j ACCEPT

sudo iptables -I INPUT -m state --state NEW -p tcp -m tcp --dport
5680 -j ACCEPT

sudo service iptables save

sudo service iptables restart

The GNU/Linux firewall should now allow other machines to connect to the database server.

NOTE

Ports 5678 and 5680 are the default ports used by the Harmony Database server. You can
customize which ports the Database server uses by editing the /USA_DB/Dbserver.conf

configuration file.

How to allow connections to the database server to go through the firewall on CentOS
7, RedHat Entreprise Linux 7 or other systems using the firewalld service

1. Addthe ports used by the database server to the list of open ports with the following commands:

sudo firewall-cmd --permanent --zone=public --add-port=5678/tcp
sudo firewall-cmd --permanent --zone=public --add-port=5680/tcp
sudo firewall-cmd --reload

The GNU/Linux firewall should now allow other machines to connect to the database server.

NOTE

Ports 5678 and 5680 are the default ports used by the Harmony Database server. You can
customize which ports the Database server uses by editing the /USA_DB/Dbserver.conf
configuration file.
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Sharing the Harmony Database Files Using NFS on GNU/Linux

Once you have a database file structure and the Harmony database server daemon, you can access the
database from the machine on which it was created. To allow other client machines on your network to access
the database, you must share its folders using NFS.

If the GNU/Linux firewall is enabled, you must add rules to allow remote connections to the NFS server so as to
allow other machines to connect to the NFS shares.

NOTE

This procedure will only allow GNU/Linux and macOS based clients to access the database. If you
want Windows clients to be able to connect to your Harmony server, see About Supporting

Windows Clients for macOS Servers on page 85.

How to configure the NFS daemon to share your database folders over the network

1. Make sure the NFS service and its utilities are installed:
sudo yum install nfs-utils
2. Enable and start the rpcbind daemon, the NFS daemon, the NFS lock daemon:

sudo chkconfig rpcbind on
sudo service rpcbind start
sudo chkconfig nfs on
sudo service nfs start
sudo chkconfig nfslock on
sudo service nfslock start

3. Then, open the configuration file /etc/exports in vi to add your database's share directories:
sudo vi /etc/exports

1. Add the following line to allow clients to access the database files:
/USA DB * (rw,sync)

2. If your database server also has a scene data storage space, add a line with a similar syntax to share
it. For example, if the scene data storage space is named /usadata000, add the following line:

/usadata000 * (rw,sync)

3. Save and exit.

4. Run the export command to update the NFS daemon with the new configuration:
sudo exportfs -r

5. Type this command to verify that the new configuration is in effect:
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showmount --exports

The utility will list all the directories currently shared through NFS.

How to allow connections to the NFS shares to go through the firewall on CentOS 6,
RedHat Entreprise Linux 6 or other systems using the iptables service

1. Open the NFS configuration file in a text editor:
sudo vi /etc/sysconfig/nfs

2. Inthe NFS configuration file, remove the hash # sign before the lines with the following content, so
as to uncomment them. This will make sure the NFS service always uses the same ports, and hence,
will allow us to safely open those ports in the firewall:

« RQUOTAD_PORT=875

+ LOCKD_TCPPORT=32803
+ LOCKD_UDPPORT=32769
+ MOUNTD_PORT=892

« STATD_PORT=662

e STATD_OUTGOING_PORT=2020

3. Add the ports and their protocols to the list of open ports with the following commands:

sudo iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport
2049 -j ACCEPT

sudo iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport
111 -j ACCEPT

sudo iptables -I INPUT -m state --state NEW -m udp -p udp --dport
111 -j ACCEPT

sudo iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport
32803 -j ACCEPT

sudo iptables -I INPUT -m state --state NEW -m udp -p udp --dport
32769 -3j ACCEPT

sudo iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport
892 -j ACCEPT

sudo iptables -I INPUT -m state --state NEW -m udp -p udp --dport
892 -j ACCEPT

sudo iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport
875 -j ACCEPT

sudo iptables -I INPUT -m state --state NEW -m udp -p udp --dport
875 -j ACCEPT

sudo iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport
662 -j ACCEPT
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sudo iptables -I INPUT -m state --state NEW -m udp -p udp --dport
662 -j ACCEPT

sudo service iptables save

sudo service iptables restart

Other machines should now be able to mount the NFS shares.

How to allow connections to the NFS shares to go through the firewall on CentOS 7,
RedHat Entreprise Linux 7 or other systems using the firewalld service

1. In aterminal, enter the following commands:

firewall-cmd --permanent --add-service=nfs
firewall-cmd --permanent --add-service=mountd
firewall-cmd --permanent --add-service=rpc-bind
firewall-cmd --reload

Other machines should now be able to mount the NFS shares.
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About Supporting Windows Clients for GNU/Linux Servers
A GNU/Linux server can natively handle requests from macOS and GNU/Linux clients. However, in order to
allow Windows based clients to connect to the server, extra steps must be followed:

e The Link Server daemon must be installed. This allows Windows clients to create symbolic links on your

macOS server.

« Your database files must be shared via the Samba protocol, which is used by Windows clients to access
the database.

o The server.ini file must be filled with information on your database server and its scene data storage
spaces. This allows Configuration Wizard to configure Windows clients automatically.

Installing the Link Server Daemon on GNU/LINUX ... 124
Running the Link Server on Log-1n on GNU/LINUX . ... e 126
Opening the Firewall Ports for the Link Server on GNU/LINUX ... ... . . 128
Sharing the Harmony Database Files Using Samba on GNU/Linux ... ... ... i 129
Opening the Firewall Ports and Configuring SELinux for a Samba Server on GNU/Linux .................... 131
Configuring a GNU/Linux Database Server for Windows Clients ... ... .. . 133
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Installing the Link Server Daemon on GNU/Linux

If you installed the database server daemon and want your GNU/Linux based server to support Windows
clients, you must also install the link server daemon. This daemon runs through the user usabatch, so this user

must be created prior to installing the daemon.

How to create the usabatch user on GNU/Linux

1. In aterminal, enter the following command:

sudo useradd -m usabatch
sudo passwd usabatch

2. When prompted, enter the password you want to assign to the user usabatch, then confirm it.

The user usabatch is now created and can be used to run Harmony daemons.

How to enable the link server daemon on GNU/Linux

1. In aterminal, enter the following command to enable the link server daemon:
sudo chkconfig toonboom link srv on

If the command returns nothing, it succeeded. The link server will launch next time you boot the

machine.
2. Tolaunch the link server daemon immediately, run the following command:
sudo service toonboom link srv start

The command will report whether it succeeded or failed.

How to enable the link server daemon using the Harmony installation script

1. Inaterminal, navigate to the directory where you downloaded the installation package.
cd ~/Downloads

2. Extract the package's contents in the directory.
tar -xvzf ./name-of-package.tar.gz

3. Switch to the directory in which the package's contents were extracted.

cd name-of-package

124



Harmony 17 Installation Guide

4. Run theinstaller with the -d parameter:

sudo ./install -1
5. When prompted, confirm that you want to proceed with the installation.

The installation script will enable and start the link server daemon.
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Running the Link Server on Log-In on GNU/Linux

If you configured your database server to launch using Service Launcher, you will also want the Link Server to
launch using Service Launcher, so that it launches in the same circumstances and environment. For more
information on running the database server with Service Launcher, see Running the Database Server on Log-
In on GNU/Linux on page 116.

If you have already enabled he link server daemon, you will need to disable the daemon first to avoid launching
two instances of the link server.

NOTE

While daemons run regardless of who is logged in and even when no user is logged-in, Service
Launcher will only run when the user for which it was specifically configured is logged in. This
means that if you want Service Launcher to launch when any user is logged in, you must configure it
for each user that has access to the machine.

How to disable the link server daemon

1. Inaterminal, type in the following commands to stop, then disable the daemon:

sudo service toonboom link srv stop
sudo chkconfig toonboom link srv off

The link server daemon will stop and will no longer launch on boot.

How to configure the link server to launch on log-in

1. Make sure you are currently signed-in as the user who will run the service.

NOTE

This user will need to be logged in for the service to be running. The user does not need
to have administrator privileges.

2. Do one of the following:

« If Service Launcher is not running, in the GNOME top menu, select Applications > Harmony
17 (Edition) > FJ§ Service Launcher.

« If Service Launcher is already running, click on its icon § in the system tray.

The Service Launcher application starts.
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3. Inthe Application parameters section of the Preferences tab, make sure that the Launch on login
option is checked, so that services configured in Service Launcher automatically launch when you log
in to your account.

4. Select the Link tab.

5. Click on Launch to verify that the Link Server launches successfully through Service Launcher.
6. Check the Launch when Service Launcher starts option.

7. Inthe top menu, select Server > Save All Settings.

From now on, the link server will launch through Service Launcher when you log in.
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Opening the Firewall Ports for the Link Server on GNU/Linux

The GNU/Linux firewall will block attempts from other computers to communicate with the database server. In
order to circumvent this, the ports used by the database server must be opened.

How to allow connections to the Samba shares to go through the firewall on CentOS 6,
RedHat Entreprise Linux 6 or other systems using the iptables service

1. Addthe port used by the link server to the list of open ports with the following command:

sudo iptables -I INPUT -m state --state NEW -p tcp -m tcp --dport
5679 -3j ACCEPT

sudo service iptables save

sudo service iptables restart

The GNU/Linux firewall should now allow other machines to connect to the database server.

NOTE

Port 5679 is the default port used by the Harmony Link server. You can customize which port
the Link server uses by editing the /USA_DB/Link_srv.conf configuration file.

How to allow connections to the Samba shares to go through the firewall on CentOS 7,
RedHat Entreprise Linux 7 or other systems using the firewalld service

1. Addthe port used by the link server to the list of open ports with the following command:

sudo firewall-cmd --permanent --zone=public --add-port=5679/tcp
sudo firewall-cmd --reload

The GNU/Linux firewall should now allow other machines to connect to the database server.
NOTE

Port 5679 is the default port used by the Harmony Link server. You can customize which port
the Link server uses by editing the /USA_DB/Link_srv.conf configuration file.
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Sharing the Harmony Database Files Using Samba on GNU/Linux

In order to allow Windows clients to access the database's directories remotely, they must be shared by the
server using the Samba protocol.

NOTE

The following commands require elevated privileges. To execute them successfully, you must either
be logged in as a user with root privileges, or precede each command with sudo.

How to install and configure Samba to share your database folders over the network

1. Inaterminal, type the following command to install Samba:
sudo yum install samba

If samba is not installed, you will be prompted to confirm the installation. Confirm and wait for the
installation to finish. If it is already installed, yum will advise you of this and quit.

2. Open the Samba configuration file to configure Samba and add your database directories as Samba

shares:
sudo vi /etc/samba/smb.conf

3. Underthe [global] section of smb.conf, add the following options:

[global]

encrypt passwords yes
blocking locks no
oplocks no

level2 oplocks no
follow symlinks yes
unix extensions no
wide links yes

4. Atthe bottom of the Samba configuration file, add the following:

[USA DB]
comment Harmony Database

browseable yes

read only no

guest ok no

create mask 0777

directory mask 0777

path /USA DB

[usa]

comment Harmony Binaries and Configuration
browseable yes

read only no

guest ok no
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create mask 0777

directory mask 0777

path /usr/local/ToonBoomAnimation/harmony[Edition] 17
[usadata000]

comment Harmony Scene Data 000
browseable yes

read only no

guest ok no

create mask 0777

directory mask 0777

path /usadata000

5. Verify that Samba understands the parameters in its configuration file with the following command:

testparm

6. Alocal user must be added to the list of users with access to the Samba shares. To do this, type in

the following command:

sudo smbpasswd -a usabatch

You will be prompted to assign a password to the user, then to confirm it. This username and
password will be used to connect to the Samba shares.

NOTE

The user you are adding to the list of Samba users must already exist as a regular user

on the machine.

7. Enable and start the Samba daemon:

sudo chkconfig smb on
sudo service smb start

Samba is now configured to give access to the database files with the selected username and

password.
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Opening the Firewall Ports and Configuring SELinux for a Samba
Server on GNU/Linux

By default, client machine will not be able to connect to a Samba server running on GNU/Linux, for two reasons:
« The GNU/Linux firewall will block incoming connections to the Samba server by default.
o SELinux will block client access to the Samba shares by default.

To work around this, you must configure the GNU/Linux firewall to accept incoming connections through the
ports commonly used by Samba. You must also configure SELinux to allow client machines to access the Samba
shares.

How to allow connections to the Samba shares to go through the firewall on CentOS 6,
RedHat Entreprise Linux 6 or other systems using the iptables service

1. Addthe ports used by the Samba service to the list of open ports with the following commands:

sudo iptables -I INPUT -m state --state NEW -p tcp -m tcp --dport
137 -j ACCEPT

sudo iptables -I INPUT -m state --state NEW -p tcp -m tcp --dport
138 -j ACCEPT

sudo iptables -I INPUT -m state --state NEW -p tcp -m tcp --dport
139 -j ACCEPT

sudo iptables -I INPUT -m state --state NEW -p tcp -m tcp --dport
445 -j ACCEPT

sudo service iptables save

sudo service iptables restart

The GNU/Linux firewall should now allow other machines to connect to the NFS shares.

How to allow connections to the Samba shares to go through the firewall on CentOS 7,
RedHat Entreprise Linux 7 or other systems using the iptables service

1. Addthe Samba service to the list of allowed services with the following commands:

sudo firewall-cmd --permanent --zone=public --add-service=samba
sudo firewall-cmd --reload

The GNU/Linux firewall should now allow other machines to connect to the NFS shares.
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How to allow connections to the Samba shares to go through SELinux

1. Allow connections to Samba to go through SELinux by entering the following command:

sudo setsebool -P samba_ export all ro=1 samba_export_all rw=1

2. Allow connections to each of your shared folders to go through SELinux by entering the following

command for each share:

sudo chcon -t samba_share t <path to share>

For example, if you are configuring a database server with the database file structure, the Harmony

binaries and configuration files and one scene data storage space labeled usadata000, you would

have to run the following command to allow access to each share:

sudo

sudo
sudo

chcon -t samba share t /usr/local/ToonBoomAnimation/harmony
[Edition] 17 - -
chcon -t samba_share t /USA DB

chcon -t samba_share_t /usadata000

3. Now, refresh the security context of each of your shared folders by entering the following command

for each share:

sudo

For example:

sudo
sudo
sudo

At this point,

restorecon

restorecon
restorecon
restorecon

-R <path to share>

-R /usr/local/ToonBoomAnimation/harmony[Edition]_ 17
-R /USA_DB
-R /usadata000

SELinux should allow other machines to connect to your Samba shares without issue.
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Configuring a GNU/Linux Database Server for Windows Clients

In order to allow Windows clients to connect to your server using the Configuration Wizard, you must fill in the
server.ini configuration file, which is located in the etc subfolder of the Harmony installation package. This file
will provide Configuration Wizard with information on the server as well as of each scene data server it is

connected to.

How to configure the server.ini file on GNU/Linux

1. Inaterminal, type in the following command:

sudo vi /usr/local/ToonBoomAnimation/harmony[Edition] _
17/etc/server.ini

2. In server.ini, typein the information for the database server as well as the directory name and
hostname of every scene data server in your network, like in the following example:

[WizardConfig]
ServerName=<server name>
InstallationDrive=C
UsaShare=<harmony share name>
UsadbDrive=C
UsadbShare=<database share name>

Replace the tags between <> brackets with the appropriate values. Make sure to remove the <>
brackets from the configuration file as well:

e <server name>: The host name of the Harmony database server.

o <harmony share name>: The name of the share that gives access to the Harmony binaries
and configuration files. By default, this share is named usa.

o <database share name>: The name of the share that gives access to the database files.
By default, this share is named USA_DB.

For example, if your database server is called harmonyserver, your Harmony installation is shared
under the share name usa and your Harmony database is shared under the share name USA_DB,

this would be the proper configuration for this server:

[WizardConfig]
ServerName=harmonyserver
InstallationDrive=C
UsaShare=usa
UsadbDrive=C
UsadbShare=USA DB
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3. Under the line starting with UsadbShare, enter information about each scene data storage space
used by your Harmony database, in the following format:

FileSystem<file system number>=C <share name> <server name>

Replace the tags between <> brackets with the appropriate values. Make sure to remove the <>
brackets from the configuration file as well:

e <file system number>: The zero-based index of the scene data storage space. For
example, the first scene data storage space for your database should be named
FileSystemO and the second one, FileSysteml.

o <share name>: The name of the share containing the scene data. Usually, this share is
either named USADATA or usadata, and its name may be followed by a zero-padded, zero-
based number indicating the index of the scene data storage space. For example, the first
scene data storage space could be named USADATA, usadata000, usadata001, etc.

o <server name>: The host name of the scene data server. If the scene data storage space is
hosted on the same machine as the database, then this host name is the same as the host
name for the database. Otherwise, you must specify the name of the machine on which the
scene data storage space is located.

For example, if this is the first scene data storage space for your database, it is hosted on a computer
named dataserver and its name is usadata000, the appropriate configuration for this would be
as follows:

FileSystem0=C usadata000 dataserver

@ IMPORTANT

The variable names and share names in server.ini are case sensitive.

NOTE

server.ini also specifies the drive letter on which the software, the database files and scene
data files are stored. Since we are configuring a UNIX-based server, there is no actual drive
letter involved. Hence, we are using the drive letter C as a placeholder so as to respect the
expected format of the server. ini configuration file, but the value of these parametersis not
relevant and will not affect your configuration.
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Creating a Scene Data Storage Server on GNU/Linux

You can create additional scene data storage spaces for your Harmony database on machines. The database
server will connect to these machines to transmit scene data to the clients, allowing you to expand the storage
capacity of your database.

Creating a scene data storage space for your Harmony database requires following these steps:

1. Creating a folder named usadata followed by the index number of the storage space at the root of the
machine.

2. Sharing the folder via NFS and, if Windows clients must be supported, via Samba as well.
3. Mounting this folder on the database server.

4. If Windows clients must be supported, adding this storage server to the server.ini configuration file.

How to create a scene data storage space

1. In aterminal, enter the following command, where ### is the padded, zero-based index of the
storage space you are creating, replace ### with 001:

sudo mkdir -m 777 /usadata###

A folder in which scene data will be stored is created at the root of the filesystem.

How to share the scene data storage space

1. Sharing a scene data storage space is done the exact same way as sharing the server's database file
system.

« Toshare the scene data storage space for macOS and GNU/Linux based clients, see Sharing
the Harmony Database Files Using NFS on GNU/Linux on page 120.

« Toshare the scene data storage space for Windows clients, see Sharing the Harmony
Database Files Using Samba on GNU/Linux on page 129

Once thisis done, you should already be able to mount the new scene data storage space on the
database server as well as on clients.

How to mount the new scene data storage space on a GNU/Linux database server

1. Inaterminal, create a folder at the root of the filesystem in which the new scene data storage space
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will be mounted with the following command, where <foldername> is the name of the scene data
directory you created on the scene data server:

sudo mkdir -m 777 /<foldername>
2. open the filesystem table in a text editor by typing the following command:
sudo vi /etc/fstab

3. Inthe filesystem table, add the following line, replacing <servername> with the name of the scene
data server and <foldername> with the name of the scene data directory you created on this
scene data server:

<servername>: /<foldername> /mnt /<foldername> nfs nfs rw,soft,intr,bg 0 0

4. Save and quit.
5. Attempt to mount the entries of the filesystem table:
sudo mount -a

6. Tomake sure that it worked, try creating a file in the new scene data storage, and verify that it's
visible from both machines. To do this:

o On one machine, enter the following command:
touch /<foldername>/testfile
o On the other machine, enter the following command to verify that testfile is present

1ls /<foldername>/

How to add the scene data storage file to the server.ini configuration file

1. Inaterminal, typein the following command:

sudo vi /usr/local/ToonBoomAnimation/harmony[Edition]
17/etc/server.ini

If the file was already configured, it most likely contains configuration in the following format:

[WizardConfig]

ServerName=<name of Harmony server>

InstallationDrive=C

UsaShare=usa

UsadbDrive=C

UsadbShare=USA DB

FileSystem0=C usadatal000 <name of first scene data server>

2. Under the last line starting with FileSystemO which contains information about an existing scene
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data storage space, enter the information about your new scene data storage space in the following
format:

FileSystem<file system number>=C <share name> <server name>

Replace the tags between <> brackets with the appropriate values. Make sure to remove the <>
brackets from the configuration file as well:

e <file system number>: The zero-based index of the scene data storage space. For
example, the first scene data storage space for your database should be named
FileSystemO and the second one, FileSysteml.

o <share name>: The name of the share containing the scene data. Usually, this share is
either named USADATA or usadata, and its name may be followed by a zero-padded, zero-
based number indicating the index of the scene data storage space. For example, the first
scene data storage space could be named USADATA, usadata000, usadata001, etc.

o <server name>: The host name of the scene data server. If the scene data storage space is
hosted on the same machine as the database, then this host name is the same as the host
name for the database. Otherwise, you must specify the name of the machine on which the
scene data storage space is located.

For example, if this is your second scene data storage space for your database server, it is hosted on
a computer named newdataserver and is named usadata001, its configuration would be as
follows:

FileSysteml=C usadata00l newdataserver

@ IMPORTANT

The variable names and share names in server.ini are case sensitive.

NOTE

The first information for a scene data storage space, C, is actually the drive letter on which the
scene data storage space is located. Since GNU/Linux does not use drive letters, there is no
drive letter for this storage space, and we are only specifying a drive letter to respect the
format of the server. ini configuration file. This value does not have an effect your server
configuration.
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Setting Up Static IPs for WebCC on GNU/Linux

It is common to configure server machines to have a static IP. This avoids having to rely on DNS resolution to
find the server when its IP address changes, and it also allows you to associate the hostname to the server's
static IP address on the machine to skip DNS resolution altogether, increasing network performance.

If your machine is currently connected to a DHCP server that dynamically assigns IP addresses, you can
configure your machine to permanently use its current IP address. To do this, you can start by making note of
the information for your current network connection, then using these parameters for a permanent IP address.

How to obtain your current network configuration on CentOS 6

1. Toobtain your machine's hostname, enter the following command:
hostname
Write down the output value.
2. Toobtain the network domain, enter the following command:
hostname -d
Write down the output value.
3. Toobtain your machine's default gateway and network device, enter the following command:
route

The output will look like this:

Destination Gateway Genmask Flags Metric Ref Use
Iface

10.120.0.0 * <subnet mask> U 1 0 0
<device name>

default <default gateway> 0.0.0.0 UG 0 0 0

<device name>

One of the rows will have default in the destination column. In this row, the name of the device in
the Iface column is the name of your default network device. Write down the name of that device.

4. Toobtain your machine's IP and subnet mask, enter the following command, replacing <device
name> with the name of the device noted in the previous step:

nmcli -f all dev list iface <device name>

Information about the network interface will appear, in either one of the following formats:

GENERAL.DEVICE: <device name>
GENERAL.TYPE: 802-3-ethernet
GENERAL.DRIVER: tg3

GENERAL.HWADDR : <MAC address>
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GENERAL.STATE: connected
CAPABILITIES.CARRIER-DETECT: yes

CAPABILITIES.SPEED: 1000 Mb/s
WIRED-PROPERTIES.CARRIER: on

IP4-SETTINGS.ADDRESS: <IPv4 address>
IP4-SETTINGS.PREFIX: <prefix> (<subnet mask>)
IP4-SETTINGS.GATEWAY : <default gateway>
IP4-DNS1.DNS: <DNS server address>

Write down the IPv4 address, the subnet mask, the default gateway as well as every DNS server

address listed.

NOTE

You can also obtain the IP address (inet addr) and network mask (Mask) of your device with
the command:

ifconfig <device name>

How to obtain your current network configuration on CentOS 7

1. Toobtain your machine's hostname, enter the following command:
hostname
Write down the output value.
2. Toobtain the network domain, enter the following command:
hostname -d
Write down the output value.
3. Toobtain your machine's default gateway and network device, enter the following command:
route

The output will look like this:

Destination Gateway Genmask Flags Metric Ref Use
Iface

10.120.0.0 * <subnet mask> U 1 0 0
<device name>

default <default gateway> 0.0.0.0 UG 0 0 0

<device name>

One of the rows will have default in the destination column. In this row, the name of the device in
the Iface column is the name of your default network device. Write down the name of that device.

4. Toobtain your machine's IP and subnet mask, enter the following command, replacing <device
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name> with the name of the device noted in the previous step:
nmcli -p -f IP4 connection show <device name>

Information about the network interface will appear. The output will be in this format.

Activate connection details (0568a4c4-092a-46e9-9f25-2295a1389d6e)

IP4.ADDRESS[1]: <IPv4 address>/<prefix>
IP4.GATEWAY: <default gateway>
IP4.DNS[1]: <DNS server address>
IP4.DOMAIN[1]: <search domains>

Write down the IPv4 address, the default gateway address, the DNS server address(es) and the
search domain(s).

To obtain your subnet mask, enter the following command, replacing <device name> with the
name of the device noted in the previous step:

nmcli -p -f DHCP4 connection show <device name> | grep 'subnet mask'

The output should look like this:
DHCP4 .0OPTION[3]: subnet mask = <subnet mask>

Write down the subnet mask.

NOTE

You can also obtain the IP address (inet) and network mask (netmask) of your device with
the command:

ifconfig <device name>

How to set up a static IP for CentOS 6 and 7

1. Before you do this, make sure you have the following information for your machine:
o Name of default network device (ie: eth0, p3p1)
o Hostname
o Domain name
o Search domain(s)

e IPv4 address
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o Network mask
o Default gateway address
o DNS server address(es)
2. Open your machine's network configuration file for editing:
sudo vi /etc/sysconfig/network
3. Configure the file as follows, replacing the bolded text with the appropriate values:

NETWORKING=yes
HOSTNAME=<hostname>.<domain name>

4. Open your default network interface's configuration file for editing. This file will be named ifcg-
followed by the name of the network interface you noted earlier. For example, if your network
interface is named eth0, the configuration file will be named ifcfg-ethO:

sudo vi /etc/sysconfig/network-scripts/ifcfg-<device name>

5. Configure the file with the appropriate values for the following parameters. If a value is already
declared for one of these parameters, replace it. If not, add it to the file:

DEVICE="<device name>"
BOOTPROTO=static
IPADDR=<IPv4 address>
NETMASK=<network mask>
GATEWAY=<default gateway>
ONBOOT=yes

6. Open the DNS configuration file for editing:

sudo vi /etc/resolv.conf

7. Configure the file as follows, replacing the bolded text with the appropriate values:

search <search domain mames>
nameserver <DNS server address>

NOTES

« If you have several search domains, enter them all on the same line after search,
separated by spaces.

o Ifyou have several DNS servers, add one nameserver line for each address.
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8. Restart the network service:

sudo service network restart
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Checking the Database Server Log on GNU/Linux

In order to troubleshoot problems with the Harmony database server, you can look through its log. This is done
differently depending on whether you installed the database server as a daemon or using Service Launcher.

If your server is configured for Windows clients, you can also check the link server log for issues.

How to check the log for the database server daemon

1. In aterminal, enter the following command:

less /tmp/tbdbserver.log

How to check the log for the link server daemon

1. In aterminal, enter the following command:

less /tmp/Link_srv.log

How to check the log for the database server in Service Launcher

1. Make sure you are currently signed in as the user running the service.
2. In the system tray, click on the Service Launcher [§ icon.
The Service Launcher application opens.
3. Select the Database Server tab.
4. Inthe bottom half, select the Log tab.

5. Click on the View Complete Log button in the bottom-right corner.

How to check the log for the link server in Service Launcher

1. Make sure you are currently signed in as the user running the service.
2. Inthe system tray, click on the Service Launcher m icon.
The Service Launcher application opens.
3. Select the Link tab.
4. In the bottom half, select the Log tab.

5. Click on